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Bu tez kapsaminda MATLAB ortaminda gelistirilmis ve dogrulanmis GeoEtrim (Geospatial
Evaluation and Training of Images) yazilimina arayiiz kazandirilmis ve yeni bagintilarla C#
ortaminda programlanmistir. GeoEtrim, goriintiilerin geometrik agidan incelenmesi ve 6zellikle
2/3B konum bilgisi elde edilmesi i¢in gelistirilen bir yazilimlar biitiintidiir. Giiniimiize dek
sadece MATLAB ortaminda gelistirilen GeoEtrim, bu ortamda gergeklestirilmesi oldukc¢a gii¢
olan yiiksek boyutlu goriintii agma ve YKN (Yer Kontrol Noktas1) ve BDN (Bagimsiz Denetim
Noktas1) toplama gibi kisitlar1 da giderecek sekilde C# programlama dilinde yeniden
kodlanmaya baslanmistir. C# siirimiinde gergeklestirilebilen islemlerden baglicalari: Proje
olusturulmasi, bir projede birden fazla goriintii eklenmesi, goriintiilerin kontrastinin
genisletilmesi, YKN ve BDN toplanmasi ve GeoTransform paneli ile algilayicidan bagimsiz
doniisiim yontemlerinden baslicalar1 (benzerlik, afin, polinom, afin izdiigiim, projektif, DLT ve
algilayicidan bagimsiz RFM) ile 2B konum dogrulugunun belirlenmesidir. Ayrica uyusumsuz
oOl¢ii ve katsay1 anlamlilik testleri de yapilabilmektedir. Yazilim, egitim ve bilimsel ¢aligmalarda
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ABSTRACT

M. Sc. Thesis

DEVELOPING A SOFTWARE FOR GEOSPATIAL INFORMATION GENERATION
FROM IMAGES
Yunus Emre ELKAR

Zonguldak Biilent Ecevit University
Graduate School of Natural and Applied Sciences

Department of Geomatics Engineering

Thesis Advisor: Assoc. Prof. Dr., Hiiseyin TOPAN
June 2019, 93 pages

In this thesis, the interface to GeoEtrim software is introduced. In addition, GeoEtrim software
has been moved from MATLAB to C#. GeoEtrim is a software developed for the purpose of
geometrical analysis of images and generation of 2/3D geospatial information. Although
GeoEtrim was developed in the MATLAB environment up to now, it is decided to continue in
C# for overcoming the challenges such as importing/reading big sized image files or collecting
GCP&ICP. Creating project, importing image(s), enhancing the image contrast, GCP&ICP
collection, and sub-package of GeoTransform, to run sensor-independent transformation
models such as similarity, affine, polynomial, affine projective, DLT and sensor-independent
RFM for 2D georeferencing accuracy assessment, are the major opportunities of the current
version. Besides, blunder and parameter validation tests are also available. GeoEtrim can be

downloaded for the scientific and educational applications free-of-charge.

Keywords: Blurring test, C#, coordinate transformation, equalization, GeoEtrim, graphical

interface, geospatial information, Image structure, invalid parameter test, software, XML
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BOLUM 1

GIRIS VE AMAC

1.1 GIRIS

Duyu organlarimizin i¢inde en biiyiik etki siiphesiz ki gorsel algilamadir. Amerika’daki ¢ocuk
iscilerinin ac1 hikayesini fotograflari ile diinyaya aktaran ve bu konuda biiyiik bir farkindalik
saglayan Amerikali linlii fotograf sanatcis1 Lewis Hine (1969), "Eger hikayeyi sozciiklerle
anlatabilseydim, yanimda siirekli bir fotograf makinesi tasimaya ihtiya¢ duymazdim."
sozleriyle, gorsel verinin Onemine dikkat c¢ekmistir (Freedman 1994). Unlii fotograf
muhabirimiz Ara Giiler’in de bu konuda “Bir yazar sandaldaki adami anlatir. Fotograf ise
insanlara sandaldaki adamin arkasindaki bulutu da gosterir.” sozii de gorselligin degerini
gostermektedir (Tiireli 2010). Yine giinlimiizde kitle iletisim araglarinin hemen hemen hepsi
gorsel veri kullanmaktadir. Reklamlar, tiiketiciyi ikna etmek i¢in s6zlii anlatimdan daha ziyade
gorsel unsurlara yer vermektedir (Giiler 2009). Egitim kuramcilar1 gorsel araglarin 6grenmeyi
daha kalic1 yaptigi savini bir takim bilimsel deneyler ile savunmaktadirlar (Giilen ve Demirkus
2014). Ug boyutlu diisiinmede, incelemede ve yorumlayabilmede gérmenin 6nemi biiyiiktiir.
Bu kapsamda yapilan ¢aligmalardan birisinde 2009-2010 6gretim yilinda 12. smiflar arasinda
36’°s1 deney grubu ve 35’1 kontrol grubu olmak tizere 71 kisilik katilimciya geometri dersi {i¢
boyutlu yazilim kullanarak anlatilmig ve gérmenin anlamli etkisi ortaya konulmustur (Eryigit
2010). Aym sekilde inkilap dersinde fotograf kullanarak anlatma (Akbaba 2005) veya cografya
dersinde de fotograflarla aktarma iizerinde yapilan ¢alismalar da insanlar i¢in gorsel araglarin

onemini ortaya ¢ikartmistir (Ugisik vd. 2002).

Bilindigi gibi ilk caglarda yasamis insanlar, yasantilarini magara duvarlarina aktarmistir. Ayni
zamanda yasam miicadelesi nedeniyle avlanma ve barinma yerlerini belirten gorsel bir dil
kullanmislar; bir nevi kartografya ¢alismalar1 yapmislardir. Konya ilinde 1963 yilinda ortaya
¢ikarilan Catalhdyiik kentinin antik haritasinin MO 6200 yilina ait oldugu sanilmaktadir (Sekil
1.1). Yazinmn kesfinin ise MO 3000’1i yillara ait oldugu diisiiniildiigiinde, kartografya bilimi
yazinin kesfinden bile eskidir (Bilgi 2006). Benzer sekilde, Nil nehrindeki su tagkinlarina karsi



miilkiyet sahiplerini belirlemek icin MO 1300 yilina ait bir harita, Babillerin MO 2300 yilina
ait kil tabletlere isledigi haritalar, Girit adasinda kiy1 yerlesimini gosteren MO 1600 yilana ait
antik harita gibi Ornekler tarih boyunca insanligin konuma baglh bilgiyi kullandigim

gostermektedir (Karagoz 2008).

Sekil 1.1 Bilinen en eski harita. Catalhdyiik bolgesine ait sehir plan1 (Fotograf: Hiiseyin
Topan).

Ingiliz devlet adami ve filozof Francis Bacon (1561-1657) Latince Meditationes Sacrae isimli
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eserinde “...bilgi egemenliktir” demektedir (Bacon 1597). Bacon, bu goriisiiniin nedenini,
“Bilgi nesnelere ve bolgeye hiikmetmenizi saglar.” seklinde aciklamaktadir. Glintimiizde bilgi,
bilisim sektorti, yazilim, donanim ve internet teknolojisi ile ¢ok hizli bir sekilde biiylimekte ve
gelismektedir. Tim sektorlerin en az %60’min bilisim sektoriine bagli oldugu tahmin
edilmektedir. Tiim bunlarla birlikte konuma bagl bilgi kullanilmasinda bilisim sektortindeki

gelismelerin 6nemli bir etkisi bulunmaktadir (Aydin 2012).

Glinlimiizde konuma bagh bilgiyi elde etmede farkli yontemler kullanilmaktadir. Bu
yontemlerden yersel konum belirleme yontemleri yakin gegmiste agirlikli olarak kullanmakta
iken giiniimiizde konuma bagl bilgi iiretimi ¢ogunlukla havadan veya uzaydan elde edilen
optik, mikrodalga, 1s1l ve lazer veriler/goriintiilerle ve uydu tabanli konumlama hizmetleri
(GNSS: Global Navigation Satellite Systems) ile elde edilmektedir (Chen vd. 2016b). Konum
belirlemede iilkeler gerek askeri gerekse sivil kullanim amagh biiyiik yatirimlar yapmaktadirlar

(Ugar ve Dogru 2005). ABD’nin (Amerika Birlesik Devletlerinin) GPS (Global Positioning



System) uydularina baglilig1 azaltmak amaciyla Avrupa Birliginin olusturdugu Galileo uydu
programi i¢in 2011-2020 yatirim planinin biitgesi 13 milyar Amerikan dolaridir (Reillon 2017).
AlphaBeta (2017) tarafindan yayinlanan rapora gore ise 2016 yilinda konumsal biligim
sektoriiniin  hasilati 400 milyar Amerikan dolaridir. Hatta 2020 yilina kadar sadece
otomobillerin navigasyon sistemlerinin toplam degerinin 250 milyar Amerikan dolara ulasacagi

on goriilmektedir (Baybal1 2018).

Konum bilgisini elde etmede giiniimiizde kullanilan yontemlerden birisi uzaktan algilamadir.
Bu yontem herhangi bir cisim ile temas kurmadan cisim hakkinda bilgi elde etmek anlamina
gelmektedir. Aslinda goérme ve isitme uzaktan algilamaya birer 6rnek diisiinebilir (Maktav ve
Sunar 1991). Gliniimiize dek uzaktan algilama ile ilgili bir cok tanim yapilmistir. Bu alandaki
en Onemli uluslararasi Orgiitlerinden birisi olan ISPRS (International Society for
Photogrammetry and Remote Sensing) tarafindan yapilan tanim: uzaktan algilama, yerde,
havada veya uzayda bulunan algilayicilardan, gezegenlerin ve Diinyanin diger fiziksel verileri
ile birlikte goriintiilerinin elde edilmesi, islenmesi ve incelenmesi bilim ve teknolojisidir (Chen

vd. 2016b). Bu kapsamda uzaktan algilama teknigi ile diger gezegenler de incelenmektedir.

Uzaktan algilama tarihsel siireci soguk savas donemine dayanmaktadir. Bu siirecte, Sovyet
Sosyalist Cumhuriyetler Birligi, 4 Ekim 1957°de ilk yapay uydu Sputnik-1’1 (55 cm ¢apinda,
83 kg agirliginda ve 4 antenli) uzaya gondererek ABD ile uzay yaris1 farkli bir boyuta tagimistir
(Cracknell ve Varotsos 2007). Ardindan NASA’nin (National Aeronautics and Space
Administration) uzay calismalari ile uzaktan algilamada sivil kullanimin 6nii agcilmistir (Reeves
1975). Bunu izleyen siiregte CNES (Centre National d'Etudes Spatiales) tarafindan atilan
SPOT-1 uydusu ve ticari bir uydu olan IKONOS uydusu gibi uydularla uzaktan algilama ile
konuma bagl bilgi tiretimi alaninda ilerlemeler hiz kazanmigtir. Uzay yarisindaki istihbarat
amagli goriintii toplama ¢aligmalar ile baslayan siire¢ glinlimiize kadar epeyce yol kat etmistir
(Sunar vd. 2011). Uzaktan algilamanin tarihgesi ile uydular hakkindaki derlemelere (Belward

ve Skeien 2015) araciligiyla ulasilabilir.

Konumsal bilisim farkli bilesenlerden olugsmaktadir. Verinin tiretilmesinde, uydu goriintiileri,
yersel yontemler veya fotogrametrik yontemler vardir. Verinin islenmesi ve bilgiye
doniismesinde de matematiksel bagintilar, istatistiksel yaklasimlar, kullanilacak metotlar ve de

cesitli donanimlara ve yazilimlara ihtiyag duyulmaktadir. Bu bilesenler Sekil 1.2°de



gosterilmektedir. Birlesenlerin tamami konumsal bilisimi olusturmaktadir. Bu tez kapsaminda

bu birlesenlerden yazilim ayagi iizerinde ¢alisilmstir.

Sekil 1.2 Konumsal bilisimin birlesenleri.

Glin gegtikce biiyiiyen konumsal bilisim sektoriiniin temel unsurlarindan birisi yazilimdir ve
gliniimiizde pek cok ticari ve akademik yazilim kullanilmaktadir. Siradan bir uygulamada ticari
yazilim kullanilmasi olagan bir durumken egitim ve bilimsel c¢alismalarda ticari yazilim
kullanmanin bazi sakincalar1 mevcuttur. Bu sakincalar, kullanilan yontemin veya algoritmanin
ayrintilarinin bilinmemesi ve yazilima miidahale kisitlamalar1 gibi bazi sinirlayici etkenlerin
varligidir. Ulkemizde de konuma baglh uygulamalarda g¢ogu bilimsel calismanm ticari
yazilimlar ile gerceklestirildigi goriilmektedir. Bu durum beraberinde, ticari yazilimlarin
otomatik olarak tanidigi veri/goriintii bi¢imlerinin ve kullanilan ydntemlerin sonuglar
iizerindeki etkisinin irdelenmeden calismalarin yiiriitilmesine neden olmaktadir. Bu sorun
sadece Ulkemizde degil, ayn1 zamanda uluslararasi diizeyde bir sorundur. Zira (Dowman 2010)
tarafindan ifade edildigi tizere ““...S0yle bir tehlike var: insanlar, kurumlar ve organizasyonlar,
nasil elde edildiklerini anlamadan veya yanlis aciklayarak veri kullaniyorlar... ...ve en azindan
Birlesik Krallik perspektifinden bakildiginda sunu diisiinmeye basladim: iiniversiteye daha

fazla geng gidiyor, fakat matematik ve bilim i¢eren ¢alismalar tercih etmiyorlar.”



Konumsal bilisim arastirmalar1 ve uygulamalart i¢in pek c¢ok akademik yazilim
gelistirilmektedir. Arastirma veya egitim ¢alismalarinda kullanabilenlerden bazilar1 asagida

verilmistir. Bu yazilimlardan bazilarinin kaynak kodlarina erisilebilmektedir.

* ESA (European Space Agency) tarafindan gelistirilen SNAP (URL-8 2016),

* OSGeo (The Open Source Geospatial Foundation) tarafindan gelistirilen QGIS (URL-16
2018) ve GRASS GIS (URL-12 1998),

« IGN (Institut National de I’Information Géographique et Forestiére, Fransa) ve ENSG (Ecole
Nationale des Sciences Géographiques, Fransa) ortakliginda gelistirilen MicMac (URL-13

2016),

« CNES (Centre National d’Etudes Spatiales, Fransa) tarafindan gelistirilen Orfeo Toolbox
(URL-14 2018),

« California Teknik Universitesi (Amerika Birlesik Devletleri) tarafindan gelistirilen COSI-
Corr (Co-registration of Optically Sensed Images and Correlation) (Ayoub vd. 2009),

» EDF R&D (Fransa) sirketi tarafindan gelistirilen CloudCompare (Girardeau-Montaut 2017),

* ISTI-CNR (Istituto di Scienza e Tecnologiedell’ Informazione — Consiglio Nazionale delle

Ricerche, Italya) tarafindan gelistirilen MeshLab (Cignoni vd. 2008),

« Rio de Janerio Devlet Universitesi Miihendislik Fakiiltesi (Brezilya) tarafindan gelistirilen E-

foto (Mota vd. 2009),

« Jade Uygulamali Bilimler Universitesi, IAPG (Institute for Applied Photogrammetry and
Geoinformatics, Almanya) tarafindan gelistirilen Phox (URL-15 2016),

« Ispanya ve Italya ortakliginda gelistirilen GRAPHOS (inteGRAted PHOtogrammetric Suite)
(Gonzalez-Aguilera vd. 2018),



« Washington Universitesi tarafindan gelistirilen VisualSFM (Visual Structure from Motion

System) (URL-19 2011),

« Cornell Universitesi tarafindan gelistirilen Bundler (Structure from Motion for Unordered

Image Collections) (URL-5 2008),

« California Santa Barbara Universitesi tarafindan gelistirilen Theia (URL-18 2016),

* Johannes L. Schonberger tarafindan gelistirilen COLMAP (URL-17 2018),

* Furukawa ve Ponce tarafindan gelistirilen CMVS (Clustering Views for Multi-view Stereo)

(URI-10 2010),

* CRCSI (Cooperative Research Centre for Spatial Information, Avustralya) tarafindan

gelistirilen Barista (URL-4 2018) ve

« Darmstadt Teknik Universitesi (Almanya) tarafindan gelistirilen MVE (Multi-view
Environment) (Fuhrmann vd. 2014) yazilimlaridir. Bu yazilimlarin ¢ogu kendi internet
sitelerinden veya GitHub iizerinden indirilebilir. Bununla birlikte akademik olarak gelistirildigi

halde ticretli olarak edinilebilen bazi yazilimlar ise:

* Leibniz Hannover Universitesi IPI (Institute of Photogrammetry and Geolnformation,
Almanya) tarafindan gelistirilen BLUH (Bundle block adjustment Leibniz University
Hannover) (Jacobsen 2008),

« 4DiXplorer (Isvigre) sirketi tarafindan pazarlanan SAT-PP (SATellite image Precision
Processing), PHOENIX, CLORAMA (CLOse RAnge MAtching), LS3D (Least Squares 3D
Surface Matching), BAAP (Bundle Adjustment with Additional Parameters) (URL-1 2008), ve

* Avrupa Birligi Projesi olan FORSAT tir (URL-9 2018). Ayrica ticari pek ¢ok yazilimin ortaya
cikisinin veya bazi alt yazilimlarimin gelistirilmesinin akademik destek ile gerceklestigi de
unutulmamalidir. GeoEtrim ile konumsal bilisim yazilimlarinin ayrintili kiyaslamasi boliim

2’de “Konumsal bilisim yazilimlar1” baslig1 altinda bulabilirsiniz.



1.2 AMAC

Bu tezin amaci, konumsal bilisim i¢in goriintiilerin geometrik acidan incelenmesi ve 6zellikle
2/3B konum bilgisi elde edilmesi i¢in akademik bir yazilimin gelistirilmesidir. Bu amacla
MATLAB ortaminda derlenen GeoEtrim (Geospatial Evaluation and Training of Images)
yazilimi C# dilinde programlanmaya baglanmistir (Sekil 1.3).

Geo€lri

geospatialy yours

Sekil 1.3 GeoEtrim’in logosu.

GeoEtrim, goriintii kullanarak konuma bagli bilgi iiretimi islemlerinin kuramsal temelde
gelistirilerek yazilim ortaminda sunulmasina ve bu sayede yeni yontemler gelistirilmesine
olanak saglamaktadir (Topan 2011). Ilk yillarinda GeoEtrim, farkli yontemlerin MATLAB
ortaminda alt yazilim paketleri olarak gelistirilmesi temeline dayanmaktadir (Topan 2011).
GeoEtrim MATLAB ortaminda, GeoTransform, GeoSpot ve Geo3ol olmak {izere 3 ayr1 alt
yazilimlarindan olusmaktadir. GeoTransform (Sekil 1.4 a) alt yazilimu ile algilayici1 bagimsiz
koordinat doniistim modelleri (2 veya 3 boyutlu afin, polinom, afin projeksiyon, projektif ve
DLT) ve algilayici bagh veya bagimsiz koordinat doniisiim modeli RFM (Rational Function
Model) kullanarak 2 boyutlu geometrik dogruluk hesaplama ve bu hesaba bagli uyusumsuz dl¢ii
ile parametrik anlamlilik testi hesaplar1 yapilabilmektedir. GeoSpot (Sekil 1.4 b) alt yazilimi
ile bir ¢ift stereco SPOT-5 HRG diizey 1A goriintiisiinden bir nesnenin konumunu blok
dengeleme ile =1 piksel dogrulukla hesaplanabilmesi ile i¢ ve dis yoneltme elemanlarinin
konum dogrulugu tizerindeki etkisi arastirilabilmektedir. Geo301(Sekil 1.4 ¢) alt yazilimi da
GeoSpot alt yazilimmin yapabildigi hesaplara 3 ¢ift stereo goriintii ile yapabilmesi icin

gelistirilmistir.



\GeoTransform

| ceoktrim - | Etrim

Spot

a) GeoTransform’un logo gorseli. b) GeoSpot’un logo gorseli.

c) Geo3ol’in logo gorseli.

Sekil 1.4 GeoEtrim’e bagl alt yazilimlarinin logolari.

Yukarida bahsedilen alt yazilimlar ayri ayr1i MATLAB ortaminda gelistirilmis olarak

mevcuttur. Ancak gerek gelistirilen bu yontemlerin tiimlesik bir yazilimda toplanmasi, gerekse

MATLAB ortaminda yerine getirilmesi gii¢ islemlerin gerceklestirilebilmesi i¢in C#

programlama dilinde yeniden derlenmesine karar verilmistir. GeoEtrim’in MATLAB siiriimii

GeoSpot, GeoTransform, Geo3ol ve GeolP adli alt yazilimlar1 kapsadig1 halde, C# siiriimii
heniiz sadece GeoTransfom’u icermektedir (URL-112018). MATLAB ortaminda olduk¢a uzun

siiren biiylik boyutlu goriintii agma ve YKN&BDN toplama gibi islemler C# siirlimiinde

kolaylikla gerceklestirilebilmektedir. Bu tez asagidaki asamalardan olugmaktadir.

a)

b)

Oncelikli olarak benzerlik, polinom, afin izdiisiim, projektif, DLT (Direct Linear
Transformation — Dogrudan Dogrusal Doniisiim) ve RFM (Rational Functions Modeli-
Rasyonel Fonksiyon Model) yontemleri anlatilmis,

Sonra dengeleme, uyusumsuzluk Olc¢li testi ve parametre anlamlilik testinden
bahsedilmis,

Visual Studio yazilimi kullanilarak C# programlama dilinde kullanici goriisleri de
alinarak arayiizler tasarlanmais,

Bircok farkli dijital goriintii bi¢imlerini taniyabilecek yazilim yapis1 gelistirebilmek i¢in
akademik yazilim gelistiricilere sunulmus yazilim kiitiiphaneleri incelenip, en uygun
yazilim kiitiiphanesi kullanilmis,

Gorilintli isleme ve ileri matematiksel islemleri esnek bir yapida ¢ozebilecek akademik
yazilim kiitiiphaneleri eklenmis,

GeoEtrim’i test etmek amaciyla Zonguldak ilini kapsayan 27.05.2014 tarihli ve 2.5 m
yer Ornekleme araligi degerine sahip GOKTURK-2 pankromatik uydu goriintiisii

kullanilmus,



g) Gorlis ve Oneriler i¢in kullanic1 grubu olusturulmus ve kullanici grubunun goériiglerine

gore hatalar giderilmis,

h) GeoEtrim’in dagitilmasi, hakkinda bilgi edinmesi ve gelistirilebilmesi i¢in kurulan web

sitesine (www.geoetrim.org) destek verilmistir.






BOLUM 2

GORUNTUDEN KONUMA BAGLI BIiLGIi URETIiMi

Gorilintliyli olusturan asil kaynak 1siktir. Gozlerimiz 151k sayesinde goriir. Fotograf makinesi,
kameralar ve goriintii algilayicilar 1s1n1m ve 1sinim enerjisi ile goriintii elde eder. Isikla yazi
yazma veya resim ¢izme yontemi olan fotografik bilinen en eski goriintii 1822 yilinda Fransiz
mucit Joseph Nicephore Niepce tarafindan iiretilmistir. Ilk gériintiiniin iiretilmesine kadar
goriintli ile ilgili birgok bilim insan1 ¢alisma yapmistir. Fotograf makinesinin en ilkel hali
karanlik kutunun tarihi M.O Cinli filozof Mozi’e (MO 490-405) kadar dayanmaktadir. Yine
karanlik oda ile ilgili Yunan filozof Aristotales’in de (MO 380-322) calismalar1 oldugu
bilinmektedir. Ayrica Leonarda da Vinci, Johannes Kepler ve Ibnii’l- Heysem karanlik kutu ile
caligmalar yaparak gelistirmislerdir. Cabir Ibn Hayyam gériintiiniin kalic1 bir yere aktarilmasi
icin ilk kimyasal calismalar1 yapmistir (Bodur 2006). Goriintii elde etme ile goziin gérmesi
arasinda benzer iliskiler kurulabilir. G6z, muhtesem diyafram ayarlar1 ile aninda 1s18a uyum
saglarlar (Hasiripi ve Recep 2001). Bakilan nesnenin boyutlarini saniyenin onda biri hizla
gorebilir. Gozde, goriintiiler retina iizerine diiser ve beyine sinyaller olarak giderken, fotograf
makinesinde goriintiiller duyarli cam veya film iizerine kaydedilir. Gézde, g6z bosluguna
karsilik fotograf makinesinde karanlik oda vardir (Kanburoglu 2005). Analog fotograf
makinalarinda yansiyan enerji bir film tizerine kaydedilir ve giimiis tozlarinin giimiis nitratlari
karartmasi gibi kimyasal tepkimelerle goriintli alinir. Gilintimiiz teknolojisi ile dijital fotograf
makinalari gelistirilmistir. Analog makinalardan farkli olarak film yerine 1s18a duyarli algilayict
bir yapt mevcuttur. Algilayiciya ¢arpan fotonlarin parlalik oranlarina gore elektronik sinyal
iiretilir ve bu elektronik sinyaller sayisal degerler seklinde kaydedilir (Aytekin ve Yal¢inkaya
2005). Boylece goriintiide en kiigiik elaman olan pikselin olugmasi saglanir. Bilgisayar

teknolojisiyle birlikte algilanan enerji saliseler i¢inde kullanilmaktadir (Lillesand vd. 2014).

Goriintl, uzaktan algilama ve fotogrametrinin temel verisidir. Fotogrametri, goriintii izerinden
nesneleri 6lgme ve yorumlama sonucu fiziksel cisimler ve bunlarin g¢evresi ile iligkileri

hakkinda bilgi olusturan ve analiz yapan bir disiplindir (Chen vd. 2016a). Uydu teknolojisi
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gelismeden Once uzaktan algilamaya dayali konumsal bilgi elde etme fotogrametik ¢aligmalarla
yapilmaktadir (Kasser ve Egels 2002). Giintimiizde de halen kullanilmakta olan fotogrametri
uzaktan algilamanin alt dallarindan biridir. Uzaktan algilama goriintiileri ise gelismis kameralar
ve algilayicilar ile donatilmis ucaklar, insansiz hava araglart ve uydular tarafindan
saglanmaktadir. Goriintiiler, elektromanyetik tayfin, ultraviyole, goriinlir ve kizilétesi gibi
bolgelerde yansiyan ve yayilan enerjinin algilayicilar tarafindan 6l¢iilmesiyle olusur (Estes
2005). Elektromanyetik dalga, uzayda ilerleyen elektrik ve manyetik alanin olusturdugu
titresimlerdir (Taskin 2019). Elektromanyetik tayf, manyetik alanda olusan titresimlerin dalga

boylarma gore siniflandirilmasina denilmektedir (Chen vd. 2016b).

Uzaktan algilama goriintiileri, nesneden yansiyan ve yayilan elektromanyetik enerjiyi uydular
tarafindan algilanarak c¢esitli bantlarda kaydedilmesi ile olugmaktadir. Kanal olarak da ifade
edilen bu bantlarda elektromanyetik tayfin mavi, yesil, kirmizi, kizil 6tesi, termal vb.
boliimlerindeki 1sinim veya 1sinim enerjisinin tamaminin veya bir kisminin sayisal veri
degerleri seklinde bulunur. Bu goriintiideki en kiigiik goriintii verisi dijital goriintiide bir pikseli
olusturmaktadir (Vezhnevets vd. 2003). Piksellerin bir araya gelmesinden satirlar veya siitunlar;

onlarin bir araya gelmesiyle de goriintii olugsmaktadir (Sabins 2013).

Uzaktan algilama goriintiilerinden konum bilgisi elde etmek i¢in nesne koordinatlarinin elde
edilmesi gereklidir. Goriintii koordinatlarindan nesne koordinatlarinin elde edilmesine genelde
“koordinat doniigiimii” olarak adlandirilan bir islemle ger¢eklestirilir. Bu islemle ayni nesnenin
iki farkli sistemdeki koordinatlarinin hesaplanmasi gergeklesir. Goriintiiden konum bilgisi
iiretiminin ilk asamasi nesne koordinatlarinin elde edilmesi oldugundan, 6ncelikle koordinat
doniisiimii kavramindan ve uzaktan algilama goriintiileri i¢in kullanimindan bahsetmek

gerekmektedir.

2.1 KOORDINAT DONUSUMU

Koordinat dontistimii iki farkli koordinat sisteminde nesnenin karsiliklarinin hesabidir. Sekil
2.1°de goriildiigi gibi 3 boyutlu iki koordinat sisteminde (X, Y, Z ve x, y, z) 3 oteleme (Xo, Yo
Zy), ii¢ donme (w, ¢, x) ve ii¢ dlgek (s, sy, s-) vardir. Olgek nesne koordinatlarinda genellikle
i¢ eksende aynidir; dolayisiyla 7 doniisiim dgesinin bilinmesiyle doniisiim ger¢eklesir (Schofiel

ve Breach 2007).
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X

Sekil 2.1 3B iki koordinat sistemi aras1 geometrik iligki.

Literatiirde birden ¢ok koordinat doniisiimii mevcuttur (Kutoglu 2001). Konumsal biligim
yazilimlarinin bir¢ogunda ve GeoEtrim yaziliminda koordinat doniistimii i¢in koordinat1 bilinen
noktalara ihtiya¢ duyulmaktadir. Bu tezin konusu olan GeoEtrim yaziliminda kullanilan

doniisiim yontemlerinin bagint1 ve agiklamalar1 agagida basliklar halinde sunulmaktadir.
2.1.1 Benzerlik Doniisiimii

Benzerlik dontisiimii 2B koordinat sisteminde doniisiim saglamaktadir. Bu modelde tek bir ag1
ve Ol¢ek soz konusu olmaktadir. Bu yontemde her iki koordinat sisteminde en az iki YKN’ye
ihtiyac vardir.

[ri] = XO] +s [COS X  —sin OC] [Xi] _ [aoo + a10X; — ao1Y; (2.1a,b)
Cl YO sin « coS X Yl boo + a01Xl' + aloyi

(2.1 a, b) numarali1 bagintida sirasiyla; » ve ¢ goriintliniin satir ve siitiin koordinatini, X ve Y
nesne koordinatini, a ve b katsayilar1 ifade etmektedir. A¢ilar bu yontemde korunur (A¢ici vd.
2003). Ancak benzerlik doniisiimii, geometrik seklin korunumunda zorlayici bir hesaplama
yaptigindan uydu goriintiilerinden benzerlik doniisiimii ile gelen hatalar diger yontemlere gore

daha yiiksek olabilmektedir (Hiiseyin TOPAN 2016a).
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2.1.2 Afin Doniisiimii

Afin doniisiimde, 2B iki koordinat sistemi arasinda doniisiim iki 6teleme, iki ag¢1 ve bir dlgek
yardimiyla gergeklesir. Afin doniisiimiinde her iki eksen i¢in 6l¢ek ve donme agis1 s6z konusu
oldugundan, uzaktan algilama goriintiilerinde satir ve siitun yoniinde farkli geometrik
bozulmalar1 dikkate alinir. Bu neden uzaktan algilama ve fotogrametride kullanilabilir. Bu
nedenle uzaktan algilama veya fotogrametride afin doniisiimii kullanilabilir(Turgut ve Inal
2003).

[rl] _ ] [sl ] [cos w —sin <p] [X] _ [aoo + a,0X; + ap1 Y} (2.2a,b)
Ci ) Szllsimg  cosw boo + b1oX; + bo1Y;

(2.2 a, b) numarali bagintida benzerilik doniisiimiine ek olarak s; ve s2 iki eksen ydniindeki
olcegi, w ve ¢ ise iki eksen etrafindaki donme acilarinmi ifade etmektedir. Afin doniisiimde

toplam 6 6ge icin en az lic YKN’ye ihtiya¢ vardir.
2.1.3 Polinom Doniisiimii

2B koordinat doniisiimiinde kullanilan (Zoej 1997) polinom doéniisiimiin genel bagintis1 su

sekildedir:

m
Z aj X/ v}

bji X[ Y/*

o

~.

Il
o
=

Il
o

(2.3 a, b)

.
NgE

~.

Il
o
=

Il
o

Burada m polinom derecesine karsilik gelmektedir. Polinom derecesi j+k < m oldugundan
matematiksel olarak sonsuz deger alabilir. Ancak GeoEtrim’de besinci dereceye kadar doniisiim

yapilabilmektedir.
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1 =Gy

+a,, X, +a,Y,

i

+a, XY, + azoX,‘2 + a02Yi2

tay XY, +ap, X Y7 + a3, X, +ay Y,

+a31Xi3Yi + alSXiYi3 + a40X;4 + 61041/;4 + asz;ZY;Z

+a32Xi3Yi2 + a23Xi2Yi3 + aSOXiS + aOSYiS + a4lXi4Yi + al4XiYi4

+...

(2.4 a, b)

3§ 3§ 3 8 8 38 8
Il
vl U1 A W N Rk O

\%

c, = b,
+b,, X, +b,Y,
+b, XY, +byy X +b,Y’
+by XY, +b, XY +b X, +b,,Y]
+by XY, +b, XY, +b, X +b,Y +b, XY’
+by, XY + b, XY + by X, + by Y, +b, XY, + b, XY
+...

(2.4 a, b)

3 3 3 8 8 38 S8
Il
vl U1 A W N R O

\Y

(2.4 a, b) numarali bagintida verilen katsayilarin, goriintiiniin satir ve siitun ( ve c)
koordinatlarina olan geometrik etkisi Petrie ve Kennie (1990) tarafindan tanimlanmistir (Zoej
1997). Birinci dereceden polinom doniisiimii aslinda afin doniisiimiidiir. Ayrica benzerlik
doniisiimii tek 6lgek ve donme acisi ile islem yapilan afin doniistimiidiir. Polinom derecesine
gore katsayr adedi n;, = (m + 1)(m + 2) seklinde hesaplanir. Doniisiim yapilabilmesi igin

katsay1 adedinin yaris1 kadar YKN sayis1 olmas1 gerekmektedir.

2.1.4 Afin izdiisiim Déniisiimii

Afin izdiistim doniisiimii yukarida anlatilan doniisiimlerden farkli olarak yiikseklik degeri de
dikkate almmarak 3B nesne uzayinin 2B goriintii uzaymna izdistimi seklinde gerceklesir
(Yamakawa 2004). Bu dontiseme yiikseklik diizeltmesi getiren afin doniisiimii de denilmektedir
(Biiytiksalih vd. 2003).

T = Ggoo + A100X; + Ao10Y; + Ag01Z;

(2.5, b)
¢i = booo + b10oXi + bo1oY: + boo1Z;

(2.5 a, b) numaral afin izdiigimii bakis dogrultusu, yavaslatma etkisi ile goriintiilemeden

kaynaklanan geometrik bozulmalar1 gidermek icin ek katsayilar kullanilarak QuickBird
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OrthoReady Standard ve IKONOS Geo goriintiileri i¢in uyarlanan matematik bagintist su
sekildedir (Jacobsen 2006):

T, = Qooo T A100Xi + Ao10Yi + Ap01Z; + a101X:Z; + ap11YiZ;

(2.6 a,b)
¢i = booo + b1goX; + bo10Y: + boo1Z; + b101XiZ; + bo11YiZ;

Ayrica OrbView-3 goriintiilerinin birbirine paralel olmayan kenarlara sahip olmasindan
kaynakli geometrik etkiyi gidermek icin getirilen ek katsayili matematiksel bagintida su
sekildedir (Biiyiiksalih vd. 2006):

T, = Qgoo *+ @100X; + Ao10Y; + Ago1Z; + 101 XiZ; + o11YiZ; + Apgo X

(2.7 a, b)
Ci = bOOO + blOOXi + bOlOYi + bOOIZi + b101XiZi + b011Yl'Zi + bllOXiYi

2.1.5 Projektif Doniisiim

Projektif dontisiim, fotogrametride en genel doniisiim modelidir. Koordinat diizlemleri birbirine
paralel, kesigsmis veya merkezi bir izdiistim olabileceginden bu yontem kullanilabilir (Yasayan

1978).

r.:a00+a10-Xi+a01-Yi
: 1+C10'Xi+C01'Yl'
C_=b00+b10'Xi+b01'Yi
L 1+C10'Xi+C01'le'

(2.8 a,b)

(2.8 a, b) numarali bagintida 2B koordinat sitemleri aras1 doniisiim s6z konusudur. Ancak 3B
nesne uzayindan 2B goriintii uzayina gecis i¢in Projektif doniisiime benzer olan DLT yontemi

gelistirilmistir.
2.1.6 DLT Déniisiimii
DLT yontemi Abdel-Aziz ve Karara (1971) tarafindan gelistirilmistir. Bu yontemde

dogrudaslik (kolinerite) esitligini yeniden diizenlenerek, i¢ ve dis yoneltme dgelerine ihtiyag

duymadan koordinat doniistimiinii gerceklestiren bir yontemdir (Abdel-Aziz ve Karara 1971).
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fi = oo + Q100 " Xi + Ag10 " Vi + Ago1 " Z;

f2 = booo + b100 * Xi + bo1o " Yi + boo1 - Z;

f3 =14 c100 " Xi + Co10 " Vi + Co01 " Zi (2.9)
Y S
Y fs Y fs

(2.9) numarali DLT koordinat doniisiimii bagintisi, i¢ ve dis yonetme elemanlarina ihtiyag
duymadan dogrudashik ilkesi ile ¢oziim yapmasinda dolay1 6zellik bilgisayar ile gérmede

kullanilan bir yontemdir.
2.1.7 RFM Déniisiimii

RFM 2000’li yillara kadar daha ¢cok ABD’de kullanilan bir koordinat diisiimii yontemidir.
(Dowman ve Dolloff 2000). Bu yontemde tedarik¢i firmalar tarafindan uydu yoriinge bilgileri
yerine RFM’lere ait katsayilar dagitilmaktadir. RFM katsay1 degerleri YKN’ler yardimiyla da
hesaplanabilmektedir. Katsayr hesaplamada, YKN’lere ait yiikseklik bilgileri de hesaba
katilmalidir (Topan 2004). YKN’lerle elde edilen sonucun dogrulugunun uydularin yoriinge
bilgisi alinarak yapilan (algilayict bagimli) yontemlere gore daha diisiik olacagi ispatlanmistir

(Hu ve Tao 2002). RFM’nin genel bagintisi su sekildedir:

mg Mj my

F=). 0D Punkizt (2.10)

g=0j=0 k=0

fi = ooo + A100Xn; + Ao10Yn; + A001Zn; + A110Xn, Yo, + Ao11Yn, Zn,

2 2 2
+ a101Xn,Zn; + A200Xn; + Qo20Yn; + @002Z7; + 111X, Y Zn;

.11
+ agzoYe, + A210X5, Yy, + A012Yn, Z5, + A120X0, Ve + A300Xs,
+ 102 Xn, 25, + Qo1 Vi Zn, + Q201 X5 Zn, + 00325,
fi f3
T, = —, Cp. = — 2.12
n; fz n; ](,;1- ( )
= (r—19)/sr, cn = (c—cp)/s¢ (2.13)
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Xn =X —Xo)/sx, o= —Yo)/sy, Zy=(Z—Z2y)/s, (2.14)

Katsayilarin altinda yazili olan ‘n’ normallestirme yapildigini, ‘0’ 6telemeyi; ‘s’ dlgegi ve
‘a, b, c, d ise katsayilar1 ifade etmektedir. Normla Buradaki derecelerin toplami (g +j + k) <
3 kosulunu saglamalidir. Normallestirme islemi ile 6l¢ii kiimesini kendi arasinda +1 araligina
getirerek, kotii kondisyon sorunu Onlenebilir. Normlandirma islemi ile ilgi bagint1 asagida

verilmektedir.

2x — Xen biiyiik — Xen kiiciik
X, = - (3.9)
Xen biyiik — Xen kiigiik

Burada xn normlandirilmis x degerini, Xen biiyik €n biiyiik ve Xen kigik en kiiciik x degerini ifade

etmektedir.

2.2 DENGELEME HESABI

Teorik anlamda kesin 6l¢li yapmak miimkiin degildir. Bir 6l¢iimde hatalarin en kullanilabilir
sekilde giderilebilmesi i¢in tekrarli 6l¢ii yapilmalidir. Yine de ancak 6l¢ii sayis1 sonsuz olmasi
halinde olcti gergcek deger ile cakisir (Bektas 2005). Dengeleme islemi ile ger¢ek deger olma
olasilig1 en yiiksek olan dengeli degerler bulunmasi igin parametreler getirilecek diizetmeler
hesaplanir. Bu diizetmeler, Olciilere (L) getirilecek diizeltmeler (v), dgelere (P) getirilecek
diizeltmeler (dP dengeleme bilinmeyenleri) ve katsayilara (RPC) getirilecek diizetmeler
seklindedir (Oztiirk 1991). Ayrica dengeleme islemi ile hatalarin diizeltilmesi yam sira katsay1
veya dgeye getirilecek diizeltmeler, ne kadar anlamli olup olmadigi, sonu¢ dogruluk iizerindeki
etkisi, aralarindaki korelasyonu, gibi 6zellikleri de ortaya koyabilmektedir (Topan ve Maktav

2014).

Yukarida bahsedildigi gibi hatalarin (diizensiz hatalar) giderilmesinde dengeleme islemi
kullanilmaktadir. Bircok dengeleme islemi vardir. Bu tez kapsaminda hatalarin dengelenmesi,
dolayl oOlgiiler dengelemesi ile gergeklestirilebildiginden dolayi, bu yontem tercih edilmistir.
Ayrica bakis acilarmin (¥) kullamildigr algilayic1 bagili yontemler hari¢ tiim yontemlerde
dolayli olgiiler dengelemesi kullanilabilmektedir (Terlemezoglu 2019). Gorilintii ve nesne

koordinat sistemleri arasinda doniistimiin genel bagintisi:
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(r,0); = F{P, (X,Y,2),} (2.1)

seklinde ifade edilebilir. (2.1) numarali bagintida, “F” koordinat doniisiimiinii modelini ifade
etmektedir. Ayrica “P” doniisiim katsayist veya dgesini, “i” ve “j” ise sirastyla YKN veya
Ogelerin indislerini, iist ¢izgi de dengeli koordinatlar1 ifade etmektedir. Dengeleme isleminde
YKN’larinin nesne koordinatlari hatasiz kabul edilir. Goriintii koordinatlarma (r, ¢) ve
katsayilara veya oOgelere (P) getirilecek diizeltme degerleri EKK (En Kiigiik Kareler)

yontemiyle dongiisel olarak asagidaki gibi hesaplanir.

I[=1l+v=1 +AdP 2.2)
— (AT A\ a1 _
dp = (474) AT(L-1|) (23)
P=p| +dP (2.4)
v=I -l+AdP (2.5)
vTy
my = + v (2.6)

Yukaridaki denklemlerde (2.2-2.6) bazi sembollerin alt isaretinde “sifir (0)” semboliin yaklasik
degerini ifade etmektedir. Ayrica bu denklemlerde, “dP” katsayilara getirilecek diizeltmeyi,
“A” dengeleme bilinmeyenlerinin katsayilar (Jakobiyen) matrisini, “mo~ birim agirlikli 6l¢iiniin
koh’u, “v” Oolgiilere (goriintli koordinatlarina) getirilecek diizeltmeleri ve “f” serbestlik
derecesini ifade etmektedir. Serbestlik derecesi, f = 2n — u (n: YKN sayisi, u: katsay1 veya

oge sayisi) seklinde hesaplanir. Dengeleme sonucunda [vv] = minvem, < 1 piksel olmasi
beklenir (Leprince vd. 2007). Katsayilarin yaklasik degerleri bilinmediginde (2.4) bagintisinda
ilk dongii igin P = dP esitligi yazilabilir. Ancak diger dongiilerde P |0 = P kabulii yapilarak

dengeleme hesabi tekrarlanir.

GeoEtrim gibi konumsal bilisim yazilimlarinda goriintii iizerinde YKN isaretlenirken hatalar

yapilabilmektedir. Ancak dengeleme islemi YKN’lar ile ger¢eklesmektedir. Bu sebepten
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dolay1 bu hatalar belirli sinirda olmalidir. Bu sinir1 asan durumlarda 61¢ii uyusumuz kabul edilir.
Uyusumsuz Olgiiler, uyusumsuz 6l¢ii testi ile tespit edilebilir. Boylece uyusumsuz 6l¢ii hesap
kiimesine dahil edilmeyebilir (Hekimoglu 2006). Tez kapsaminda gelistirilen GeoEtrim

yaziliminda iki farkli uyusumsuz 6l¢ii testi tercih edilmistir.
2.3 UYUSUMSUZ OLCULERIN BELIRLENMES]

Olgii hatalari, dogal veya kullanict miidahalesiyle olusabilecek hatalardir. Hatalar kaba,
sistematik ve rastgele olmak {lizere ilige ayrilirlar. Sik tekrarli Olciilerle kaba hatalar giderilir.
Sistematik hatalar ise diizeltme denklemleri olusturularak giderilirken rastgele hatalar ise

uyusumsuz Ol¢tiler kavrami ile dengelemeye konu olmaktadir (Demirel 2003).

Her bir 6l¢iiniin ayr1 ayr1 bir katsayisi vardir. En biiyiik katsay1 uyusumsuz ol¢iiden gelmektedir
(Baarda 1968). Dolayisiyla bu hatali 6l¢iiyii tespit etme ve Olcili kiimesinden ¢ikarmak veya
dengeleme islemini yenilemek gerekmektedir. (Demirel 2003). Uyusumsuz Ol¢ii tespiti i¢in
literatlirde bir¢ok yontem kullanilmaktadir. Yaygin olarak kullanilan yontemler; geleneksel
(klasik) test yontemleri ve robust yontemleridir (Yetkin vd. 2009) .Geleneksel (klasik)

uyusumsuz test yontemleri:

e Baarda yontemi (Normal dagilim),
e Pope yontemi (Tau testi) ve
e t-student yontemi olmak iizere 3 tanedir. Bu test yontemlerinden test biiyiikliikleri, Baarda

yontemi igin,

|v;

7, \@ 2.7)

Pope yontemi igin,

T,, =

v.
. _ Il

" So /vi.. 28)

t-stundent yontemi i¢in
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fi= —— (2.9)

22T O (2.10)

Seklinde hesaplanir. (2.2-2.6) numarali bagintilarda “ T,,” Baarda test biiyiikliigiinii, “T,,” Pope

2

test biiyiikliiglinii, “T” t-student test biiylikliigiinii, “v;” Ol¢iilerin diizeltmesini, “o;” Ol¢ii

diizeltmelerinin standart sapmasini ve “Q,,,,” diizeltmelerin ters agirlik matrisini ifade eder. “o,”

onctl varyansi, “s,” ise soncul varyansi ifade etmektedir.
Bu tez kapsaminda gelistirilen GeoEtrim’in GeoTranform modiiliinde uyumsuzluk 6l¢ii testi

yapilabilmektedir. GeoTraform alt yazilimda, geleneksel (klasik) uyusumsuz 6l¢ii testlerinden,

normal dagilim ve t-student dagilimi1 yontemlerinde uyusumsuz 6l¢ii testi yapilabilmektedir.
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BOLUM 3

YAZILIM GELiSTIRME

Algoritma sorunu ¢ozebilmek icin gerekli olan sirali mantiksal adimlarin tlimiine denir. Bir

algoritmanin sorunsuz calisabilmesi igin:

e Her adim son derece belirleyici olmalidir. Higbir sey sansa bagli olmamalidir.
e Belirli bir sayida adim sonunda algoritma sonlanmalidir.

e Algoritmalar tiim ihtimalleri ele alabilecek kadar genel olmalidir (Vatansever 2011)

Yazilim ise bir amaci uyum iginde gerceklestirmek icin elektronik aletlerin nasil ¢alisacagini
diizenleyen makine dilidir. Bir yazilim yazmadan 6nce matematiksel modelin dogrulugunda
emin olunmalidir (Sharp 2010). Yazilimin yasam dongiisii boyunca baglangi¢ adimlarina her
zaman ihtiya¢ duyulabilmektedir. Programlama dilleri zaman igerisinde gelisim ve degisim
gosterebilmektedir. Giiniimiizde 650’den fazla programlama dili oldugu diistiniiliince oldukca
onemlidir (Kernighan ve Ritchie 2006). Yazilim gelistirilmesinde takip edilmesi gereken

adimlar Sekil 3.1 de verilmistir (Bertsekas 2005).
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SISTEM ANALIZi

TASARIM >
ALGORITMA
PROGRAMLAMA
DERLEME
TEST

Sekil 3.1 Yazilim gelistirme akis diyagramu.

HE

e

Sekil 3.1°de gorildiigli gibi yazilim gelistirme islemin herhangi bir adimda bir sorunla
karsilasildiginda bir 6nceki adima veya daha onceki adimlara geri doniilmelidir. Hatta sorun
ctkmasa bile yeni ihtiyaclara gére en basa doniilmelidir. Yazimla ilgili sorunlar yazilimin
derleme esnasinda kaynak kodlardan kaynaklanan hatalar veya makine kodunda ¢alisma
zamani hatalar1 olabilir. Yazilimda kodlamalarin, programlar tarafindan kodlarin

makinediline derlenerek calismasina yazilim yasam dongiisii denmektedir (Sekil 3.2).

DERLEME
A

KAYNAK VINGOY CALISMA

v

KOD KODU

Yazilim hatasi Calisma zaman hatasi
(Syntax Error) (Run-time Errors)

Sekil 3.2 Yazilim yasam dongiisii.
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3.1 KONUMSAL BIiLIiSIM YAZILIMLARI

Giris boliimiinde konumsal bilisim yazilimlarinin bazilar1 hakkinda kisaca bahsedilmektedir.
Bu akademik yazilimlarin ortak o6zelligi kendi icinde 6zgilin olmalari. Kullanict gerek
fotogrametride gerekse 3B nokta bulutu gibi konumsal bilgiye dayali caligmalarda bu
yazilimlardan faydalanabilmektedir. Bu yazilimlardan, QGIS, MicMac ve Orfeo Toolbox gibi
bazilar1 agik kaynakli yazilimlardir. Bunlar yazilimin kaynak kodlarim1 kullanicilara
sunmaktadirlar. Boylece tiim kullanicilara programin gelistirilmesine katki saglayabilme
olanagini verilmistir. Buna 6rnek olarak kiiresel goniillii bir¢ok yazilimeinin olusturdugu
OSGeo toplulugunun gelistirdigi QGIS yazilimi1 verilebilir. GeoEtrim’de bu 6zgiirliik anlayisini

benimseyerek gelismeyi hedeflemektedir.

GeoEtrim, Zonguldak Biilent Ecevit Universitesinde temeli atilmis, lisans ve lisansiistii
Ogrenim siiren 6grencilerin katkilariyla gelismis ve gelismektedir. GeoEtrim gibi Rio de Janerio
Devlet Universitesi Miihendislik Fakiiltesi (Brezilya) tarafindan gelistirilen E-foto projesinin
ardindaki fikir de 6grencilerin fotogrametrinin arkasindaki prensipleri anlamalarina yardime1
olacak basit bir yazilim seti (iicretsiz Dijital Fotogrametrik Is Istasyonu) sunmaktir. E-foto bu
amaca da Ozgilir ve kullanict dostu fotogrametrik yazilimin gelistirilmesiyle ulagsmay1

amaglamaktadir (URL-6 2014).

Konumsal bilisim yazilimlarindaki cesitlilik farkli kullanici arayiizlerinin olmasina da neden
olmustur. Esasen matematiksel alt yapisi ¢ok gii¢lii olmasina ragmen kullanici arayiizii olmayan
konumsal bilisim yazilimlar1 da vardir. Bunlardan biride, IGN (Institut National de
I’Information Géographique et Forestiére, Fransa) ve ENSG (Ecole Nationale des Sciences
Géographiques, Fransa) ortakliginda gelistirilen MicMac yazilimidir. MicMac'in  giiglii
yanlarindan biri, yiiksek derecede cok yonliiliigidir. Cok yonlilik cesitli alanlarda,
(haritacilik, ¢evre, endiistri, ormancilik, arkeoloji... vb.) kullanilabilirliginden
kaynaklanmaktadir. MicMac, 3B modellerin ve orto-goriintiilerin olusturulmasinda da

kullanilabilmektedir (URL-13 2016).

Kullanict kolayligi acisindan gelistiriciler yazilim arayiizlerinde farkli yaklasimlara
gitmisglerdir. e-foto’nun arayiiziinde caligsma alan1 takip paneli ve "auto locate” gibi 6zellikler
vardir. Bu Ozelikler GeoEtrim yaziliminda da tekrar tasarlanmistir. Yazilim gelistirilmesi

boliimiinde bu 6zelliklerden ayrintili sekilde bahsedilecektir.
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Yukarida bahsedildigi gibi konumsal bilisim sektoriinde akademik veya ticari bir¢ok yazilim
vardir. GeoEtrim’i gelistirirken e-foto, QGIS, MicMac, CloudCompare... vb. bir¢ok yazilim
incelenmistir. Kullanici ara yiizii tasariminda 6zgiin ve kolay olabilmesine 6zen gosterilmistir.
GeoEtrim yazimi ve GeoEtrim’e bagli GeoTranform alt yazilimmin gelistirilmesi basliklar

halinde asagida verilmistir.

3.2 YAZILIMIN YAPISI

Bu boliimde alt bagliklar seklinde GeoEtrim’in arayliz tasarimlari, matematiksel ¢éziimleri ve
ozgiin Ozellikleri anlatilmaktadir. GeoEtrim’de C# programlama dili kullanilmistir. Bu dil,
Microsoft tarafindan 2001°de C ve C++ programlama dillerinden gelistirilmistir (Sharp 2010).
C# kodlama yapis1 bu iki dile kiyasla olduk¢a kolay olmakla birlikte C++’dan daha fazla nesne
tabanli ve performans agisindan da C ile rekabet edebilecek diizeydedir. Ancak bu iki dilden
farkli olarak C# dogrudan makine diliyle biitiinlesmis degildir. Bu yiizden Windows isletim
sisteminde “.Net Framework™, Linux isletim sisteminde ise “Mono” denilen ayr1 bir
doniistiirticii platform yapisi ile ¢alisir. Bu da C#’1n olumsuz bir yani olarak kabul edilebilir
(Ege 2012). .Net Framework, Microsoft tarafindan gelistirilen Windows isletim sistemleri i¢in
tasarlanmig yazilim gelistirme platformudur. GeoEtrim, .Net Framework’iin 4.6 siirimiinde
gelistirilmistir. Bu platformda Visual Basic, C#, C++, J++, J#, F# ve Asp.net gibi dillerinde de
yazilim gelistirilebilmektedir. Temelde .Net Framework bu dilleri kendi i¢inde ortak bir dille
dontistiirtir. Bu ortak dile CLR (Common Language Runtime) denir. Daha sonra derleyici
program CLR’yi makine diline doniistiiriir. Bu durum derleme esnasinda performans kaybina
yol agmaktadir. C# dili sadece .Net Framework alt yapis1 ile calisabilmektedir. Ayrica .Net
Framework platformun yazilim gelistirmeyi kolaylastiracak iki yap1 mevcuttur. Bu yapilar isim
alan1 (namespace) ve temel sinif kiitiiphanesidir (BCL: Base Class Library). Bu kiitiiphanede
yazilim araylizii i¢in bir¢ok nesne bulunmaktadir (Kizmaz 2013). GeoEtrim’de kullanilan
nesnelerin ¢ogu bu kiitiiphaneden bi¢imlendirilerek sunulmustur. Bu nesneler: ikonlar, tuslar,
paneller, formlar, yaz1 kutulari vb. seklinde siralanabilir. Ayrica BCL kiitiiphanesiyle
GeoEtrim’de basta temel matematik fonksiyonlart olmak {izere bir¢ok fonksiyon ve degisken
tipi de kullanilmistir. GeoEtrim’de bu kiitiiphanenin diginda kullanilan bagka kiitiiphaneler ise
GDAL (Geospatial Data Abstraction Library), EmguCV ve ALGLIB’dir (Numerical Analysis
Library).
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GDAL, OSGeo tarafindan C#, Python, Java ve Perl dillerinde raster ve vektor verilerin
okunmasi, islenmesi, analizi, ¢evrimi ve yazilmasi islerinin yapilabildigi bir kiitiiphanedir.
Giliniimiizde dijital goriintii isleyen sirketler tarafindan kullanilan birgok goriintii dosya bigimi
vardir. Yine farkli uzaktan algilama uydularimin farkli goriintii dosya bigimleri GDAL ile
okunabilmektedir. GeoEtrim’de kullanilan GDAL kiitiiphanesinde geotiff, tiff, bmp, png, jpeg,
jpeg2000, pix gibi 155 farkl raster dosya yapisi tanimlanmistir (OSGeo, 2018).

EmguCV, Emgu sirketi tarafindan, .Net Framework dillerinde sunulan goriintii isleme
kiitiiphanesidir. EmguCV’nin temeli Intel sirketi tarafindan sunulan OpenCV (Open Source
Computer Vision Library) kiitiiphanesine dayanmaktadir (Erigti 2010). Ancak OpenCV, C ve
C++ dillerinde kullanilabilmekte iken C# ortaminda kullanilamamaktadir (Shi 2013).
GeoEtrim’in arayiiziinde goriintii panelleri EmguCV’in sundugu nesneden bi¢imlendirilmistir.
GeoEtrim’de EmguCV’nin islevleri ve degiskenleri oldukg¢a sik kullanilmistir. Goriintiiye
yakinlagsma veya uzaklagsmada, goriintiiniin karsithigini artirma veya azaltmada, goriintii
histograminin gosteriminde, histogram esitlemede, goriintii iizerinde isaretlemelerde ve
ozellikle GeoEtrim’in  GeoTransform alt yazilimmin matris islemlerinde EmguCV

kiitliphanesinin fonksiyonlar1 kullanilmigtir (URL-7 2018).

ALGLIB, ALGLIB Project sirketi tarafindan C++, C# ve Delphi dillerinde ¢apraz-platform
desteginde (birden fazla isletim siteminde c¢aligilabilir) sayisal analizi ve veri isleme
kiitiiphanesidir. ALGLIB kiitiiphanesinde 2/3B geometrik islemler i¢in ¢ok sayida islevler ve
degiskenler mevcuttur (URL-2 2018). Ancak ALGLIB Kiitiiphanesi sadece GeoTransform alt
yaziliminda t dagilimindaki degerin elde edilmesi i¢in kullanilmistir. GeoEtrim’de kullanilan

kiittiphanelerin kullanim amaglar1 6zetle:

BCL: Arayiiz nesneleri, temel hesap iglemleri, dosya okuma ve yazma, sistemsel ayarlar,
e GDAL: Raster dosyalarin okunmasi,
e  EmguCV: Arayiiz nesneleri, matris islemleri ve goriintii isleme,

e ALGLIB: Istatistik hesab1 seklindedir. GeoEtrim’in genel is akis semas1 Sekil 3.3’te

sunulmustur.
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Sekil 3.3 GeoEtrim’in genel is akis semas.

GeoEtrim’in tiim degiskenleri, kod agiklamalar1 ve arayiizii ingilizce dilinde yazilmistir.
Boylece uluslararasi diizeyde kullanict hedefini saglamanin yaninda tiim diinyadan
gelistiricilerin yazilim ekibine katilimlarina da olanak verecektir. Arayiizlin basta Tiirkge dil

secenegi olmak iizere baska dillerde de sunulmasi hedeflenmektedir.
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3.2.1 Ana Pencere

GeoEtrim, Windows isletim sisteminde gelistirildiginden Windows 7 ve 10 isletim sitemlerinin
64 bit siiriimiinde kurulabilecek sekilde derlenmistir. ilerleyen siiregte farkli isletim sistemlerine
uygun siiriimlerin hazirlanmasi da olasidir. Arayiiz tasariminda kullanicinin kullanim kolayligi
ve ihtiyaclart dikkate alinmistir. Bu nedenle, profesyonel herhangi bir yazilimda olmasi gereken

menii gubugu ve menii cubugunun hemen altinda kisa yol ¢ubugu tasarlanmistir (Sekil 3.5).

A4 GeoEtrim (2018.01) . - - =] x
File Teols Modules Help <— Menu cubugu -
B e et n L e+t 4 b o ———— KiSayol cubugu
~ Profect: cmek_proge gor
o Image: IMG_20161228_110731 jpg
@ Banch

Red band

Green band
o Blue bans
{v] Gepace

Y e 300111] Goriintii paneli
5 49 Bands
(] acrace

Dosya diizen paneli

Takip paneli

ey R— )| 113011y RS TULT

Sekil 3.4 GeoEtrim ana ekran goriiniimii.

Calisir durumdaki meniiler:

1. Project (Proje)
a. New Project (Yeni Proje: Yeni bir proje olusturma, proje dosya formati: .gpr)
b. Open Project (Proje Ag: .gpr uzantili mevcut bir projeyi agma)
c. Save Project (Proje Kaydet)
d. Close Project (Proje Kapat)
e. Exit (Cikis)
2. Tools (Araglar)
a. Image (Goriintii)

i. Open (A¢)
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ii.

iii.

Empty Image

Contrast (Karsitlik: Goriintii karsithigr genisletme islemleri)

b. GCP (YKN)

1.

ii.

GCP/ICP Collection (YKN/BDN Toplama)
Export (Txt Olarak Cikar: YKN/BDN’lerin .gcp uzantili olarak

kaydedilmesi)

iii. Visual Settings (Gorlinim  Ayarlari:  YKN/BDN’lerin  gdsterim
ozelliklerinin belirlenmesi)
3. Modules (Alt yazilimlar)

a. GeoTransform

seklindedir. Bu meniilerden 6nemli bazilar1 (yeni proje olusturma, mevcut projeyi agma, projeyi
kaydetme, goriintii agma, gorilintii silme, kullanimdaki goriintiiniin adin1 gdsterme, goriintii
biiyiitme, kiigiiltme ve sabit degere getirme, goriintliide en alt, {ist, sag ve sola gelme, karsitlik

genisletme ve YKN/BDN toplama) kisayol ¢cubugu alaninda yer almaktadir (Sekil 3.5).

= £ | Active: None

L

Sekil 3.5 GeoEtrim’de gelistirilen kisayol ¢ubugu.

Dosya diizen paneli, ¢alisilan proje, goriintii ve buna bagl bilgilerin hiyerarsik yapisini
gorebilmek icin tasarlanmistir. Eger ¢ok bantli bir goriintii agilmigsa her bir bant ve

histogramlar1 ayr1 ayr1 goriintiilenebilir (Sekil 3.6).

L _JImage: lyrsick_23456_10092016 4

- Bands
Red band

Histogram

Intensity

Green histogram
- Jll Blue band

Blue histogram
=8

=il Band 5
Band 5 Histogram
{(¥) ceeace

Count (10°6)

b) 5. Banta ait
ornek goriintii

c) 5. Banta ait histogram
grafigi

a) Bantlarin dosya diizen
panelinde gosterimi

Sekil 3.6 GeoEtrim’e ana pencereden ulasilabilecek bilgiler.

GeoEtrim’de goriintii verisi olmadan, sadece nokta verisiyle ¢alisma imkanin1 da kullaniciya

sunacak sekilde tasarlanmistir. Boylece her hangi bir goriintiiye ihtiya¢ duymadan sadece nokta
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verisi ile islem yapmak miimkiin hale gelmistir. Sag tarafta goriinen takip panelinde goriintiiniin
tamami sabit oranda kiigiilecek ve panele yerlesecek sekilde kodlanmistir. Takip panelinde
goriintii  panelindeki c¢alisilan bolgenin kirmizi bir dikdortgen tarafindan anlik olarak
gosterilmesi saglanmistir. Ayrica imlecin goriintii koordinatlar1 ve goriintli yakinlasma degeri

bilgilendirme ¢ubugunda goriilebilmektedir (Sekil 3.4)

Goriintli panelinde, agilan goriintiiniin {izerinde her hangi bir noktaya anlik fare imleci ile
gelindiginde bilgilendirme c¢ubugunda o goriintliniin gorilinti koordinatlar1 “Row-Column
(satir-siitun)” kullaniciya sunulmaktadir. Bununla goriintii koordinat bilgisi ekranda
kullanicinin gérmesi saglanmaktadir. Ayrica nokta toplama penceresi yardimi ile goriintii

koordinatlarina gore goriintii lizerine isaretleme yapilabilmektedir.

3.2.1.1 Gériintii Koordinatlarinin Okunma Ozelliginin Gelistirilmesi

Bilgisayar ortamindaki koordinat sistemi ekran koordinat sitemidir. GeoEtrim gibi konumsal
bilisim yazilimlarinda konumsal bilgi i¢in goriintii koordinatlarina ihtiya¢ vardir. Yazilimin
arka planinda ekran koordinatlarindan gériintii koordinatlar1 elde edilmektedir. Iki koordinat
sistemi de birbirine paralel ve iki boyutlu dogrusal bir sistemdir. Ekran koordinat sisteminde
ekranin sag iist kosesi orijin noktasidir. Bu noktadan asagisina dogru piksel olarak y koordinati
ekranin sagina dogruda x koordinati biiyiir. Goriintii koordinat sisteminde ise orijin goriintiiniin
sag iist noktadir. Bu noktadan “r”

ve Dewitt 2000).

piksel olarak asag1 “c” piksel olarak saga dogru biiyiir (Wolf

GeoEtrim gibi yazilimlarda gorilintlinliin agilacagi panel ile goriintiiniin boyutlar1 ayni
olmamakla birlikte genelde goriintii panelden biiyiiktiir. Bunu ¢6zmek i¢in hemen hemen her
yazilimda goriilebilecegi gibi ekran ilizerine kaydirma ¢ubuklari (scrollbar) kullanilmaktadir

(Sekil 3.7).

¢ [ I | )

Sekil 3.7 Kaydirma (scrollbar) cubugu goriiniimii.

Goriintli ekran iizerinde kaydirilarak calisma alani degistirilebilmektedir. Burada dikkat

edilmesi gereken nokta kaydirma miktaridir. Zira ekran koordinatlar1 yazilimda sabit ve sag iist
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koseden baslamaktadir. Goriintii koordinatinin elde edilebilmesi i¢in ekran koordinatina
kaydirma gubugunun kaydirma miktari eklenmelidir. Ayrica iki koordinat sisteminde goriintiide
eger ki yakinlasma veya uzaklasma olursa koordinat sistemleri arasindaki olg¢ekler farkli
olacaktir. Dijital koordinatlardan goriintii koordinatlarina doniistimde bu 6l¢ek farki dikkat
edilmelidir. Goriintiinlin agildig1 panelden goriintiiniin koordinatlarini elde etme bagintisi

asagida verilmektedir.

T=Sx+Ximg/¢

3.1a,b
C=Sy+Yimg/¢ ( )

Ozetle goriintii koordinati (7, ¢) elde edebilmek igin goriintii panelinin ekran koordinatina (Xing,
Yimg) goriintliiniin kayma ¢ubuklari ile kayma miktar1 (Sy, Sy) eklenmelidir. Ayrica yine goriintii
koordinati elde edebilmek i¢in goriintiiniin yakinlasma veya uzaklasma oranina gore olgek
diizeltmesi (¢) getirilmelidir. Bu o6l¢ek diizeltmesi GeoEtrim’de basit bir oran hesabi ile
¢coziilmiistiir. GeoEtrim’de goriintii koordinatlarinin okunmasi i¢in gelistirilen algoritma 6zet

kodu Sekil 3.8”de verilmistir.

/I (row-col) okuma iglemi

float realx, realy; // goriintii koordinatlar: degikeni

realx = HScrollBar + (imgX / ZoomScale); // HScrollBar= kayma miktari, ZoomScale=odl¢cek
realy = VScrollBar + (imgY / ZoomScale)); // VScrollBar=kayma miktari, ZoomScale=dl¢ek
// imgX ve imgY = Goriintii panelinin ekran koordinatina

Sekil 3.8 Goriintii koordinatlarinin goriintii panelinden okuma algoritmasi 6zet kodu.

3.2.1.2 Goriintiiye Yakinlasma/Uzaklasma Ozelliginin Gelistirilmesi

Goriintiide yakinlasma veya uzaklasma islemleri matematikte kestirim yontemleri ile
gerceklesmektedir. Literatiirde yakin komsu, bilineer, bikiibik, polinom, dogrusal ve dairesel
gibi kestirim yontemleri vardir. Gorilintli verisinden istenilen duruma gore en uygun kestirim
yontemi se¢ilmelidir (URL-3 2018). GeoEtrim’de standart olarak tercih edilen yontem yakin
komsu kestirimi (sifirinc1 derece kestirim) yontemidir. Bu yontemde goriintii pikselleri aras1 gri
deger gecisi keskindir. Bu yiizden estetik bir gériiniim saglamaz. Ancak gercek goriintii verisi

ile yapilan ¢aligmalarda pikseller arasi gecisin ayirt edilebilir olmasi gerekmektedir. Ayrica bu
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yontemde hesap yiikii az oldugundan hizli bir sonug alinabilmektedir. Bu yiizden GeoEtrim’de

komsu kenar kestirimi (Sekil 3.9) kullanilmistir (Danahy vd. 2007).

Aiiie St 4okl & i LR (et o @&

a) Yakinlastirilmamig goriintii b) Yakinlastirilmis goriintii

Sekil 3.9 GeoEtrim’de yakinlastirma dncesinin ve sonrasinin gosterimi.

3.2.1.3 Gériintiiniin Karsithk Degisime Ozelliginin Gelistirilmesi

GeoEtrim, goriintiiniin karsithiginin kullanici tarafindan degistirilmesine olanak verir (Sekil
3.10). Kullanic1 ihtiyag duydugu seviyede karsithgi degistirerek karsiligi daha diisiik veya
yliksek bir goriiniim saglayabilir. Ayni zamanda histogram esitleme islemi de yapabilmektedir.
Kargithk ayar1 degistirme veya histogram esitleme gibi temel radyometrik dontistimler
kullanicilarin  goriintiideki ayrintilar1 kigisel algilarina uygun olarak ayarlayabilmelerini

saglamaktir (Kalisperakis vd. 2006).
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Karsithik degistirme dncesi Otomatik karsitlik degistirme sonrasi

Sekil 3.10 GeoEtrim’de karsitlik degistirme Oncesinin ve sonrasinin gdsterimi.

Karsitlik degistirme panelinde kullanicinin tercih ettigi katsayiya gore piksellin gri degerlerinde
dogrusal artis veya azalis olmaktadir. Bunun i¢in kullanicinin hareketinde parcali cubuk

(trackbar) olarak ifade edilen yap1 gelistirilmistir (Sekil 3.11).

A ot ol @
' 1 Default

Contrast

() pefualt () Auto ® Manual [ Histogram

equalization

Sekil 3.11 Karsithik ayarii degistirmek icin gelistirilen parcali gubuk (trackbar).

Karsithk degistirme panelindeki katsayi, piksel gri degerindeki c¢arpani belirlemektedir.
Kullanict pargali ¢ubuk ile ayarladig1 katsayi ile goriintii pikselleri ¢arpilmaktadir. Boylece
goriintii gri degerlerinde dogrusal (lineer) artis meydana gelir. Gri degerler 8 bitlik bir goriintii
icin 0-255 tamsay1 aralifinda deger almaktadirlar. O siyaha 255 beyaza karsilik gelmektedir.
Gorlintlintin karsithig artirmak icin her bir pikseli belirlenen katsayida ¢arpmak germektedir.
Bu durumda 8 bitlik goriintiide 255’1 asan pikseller meydana getirebilmektedir. 8 bitlik
gorlintiide 255’1 asan piksel degeri olmayacagindan 255’1 asan deger 255°e ¢ekilmistir. 16 bitlik
goriintiide de karsitlik katsayi ile carpilan pikseller 65535 degerini gegmemesi gerekmektedir.
Gecgen piksel degerleri 65535 degerine ¢ekilir. Ancak bu igslemin tersinde ayni sey s6z konusu
degildir. Goriintliniin karsithik diisiiriiliirken kullanicinin belirledigi katsayiya tiim pikseller

boliiniir. Piksel degeri 8 bitlik veya 16 bitlik goriintiide sifirin altinda olamamalidir. Zaten belirli
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bir katsayiya boliinen pikseller matematiksel olarak sifirin altinda olmasi miimkiin olmadigi
icin iist sinir belirlendigi gibi alt sinir belirlenmesine gerek yoktur. Ciinkii piksel gri degeri
pozitif olarak neye bolersek bolelim asla sifirin altina diigmez. Bu durumda karsitlik degistirme
bagintis1 ¢ikarilirken sadece iist sinir belirtilmesi yeterlidir. Karsitlik degistirme bagintisi

asagida verilmistir.

" eger(i k) > 255 — i*k = 255 (8 bit ise)

z ixk (3.2)

i=0 eger(i * k) > 65535 — i xk = 65535 (16 bit ise)

(3.2) Numarali bagintida “n” goriintiideki tiim piksellere karsilik gelmektedir. “4” karsithik
degistirme katsayisini ifade etmektedir. GeoEtrim’de kullanici karsithk degistirme katsayisini
manuel olarak kendi belirleyebildigi gibi otomatik olarak programda belirleyebilmektedir.
Sekil 3.11°de goriilen karsitlik degistirme panelinde pargaligi cubugun (trackbar) altinda ¢coktan
segmeli diigmelerden (Radio Button) otomatik (auto) diigme se¢ilmesi durumunda. Program
parcali ¢ubugu geri planda yaptig1 hesaba gore uygun konuma cekecektir. Buda 8 bitlik
goriintlide goriintiideki piksel degerlerinin ortalamasi “85,3” olacak sekilde uygun katsayiya
cekilmesi seklinde belirlenmistir. 16 bitlik goriintiinde ayn1 oranda karsilik gelen piksel ortala

degeri 21922.1°dir. Karsitlik degistirme algoritmasinin 6zet kodu Sekil 3.12°de verilmistir.

for (i=0 ; i<n ; i++) // tim pikselleri sira ile tara

{
pixel[i] = piksel[i] * k ; // “k” karsitlik degistirme katsayist ile carpimi
if (bit == 8) // 8 bitlik goriintii ise
if ( piksel[i] > 255) piksel[i] = 255; // piksel 255 degerini asarsa 255 e ¢cek
if (bit==16) // 16 bitlik goriintii ise
if (piksel[i] > 65535) piksel[i] = 65535 // piksel 65535 degerini asarsa 65535 e ¢cek

Sekil 3. 12 Karsitlik degistirme algoritmas1 6zet kodu.

3.2.1.4 Takip Paneli Ozelliginin Gelisitirilmesi

Tezin 6nceki kisimlarinda GeoEtrim gibi konumsal bilisim yazilimlarinda goriintiiniin agilacagi
panel ile goriintliniin biiyiikliiglinlin ayn1 olmayabileceginden bahsedilmisti. Bununla birlikte
genellikle uzaktan algilama goriintiilerinin biiytkligli, yazilimdaki goriintliniin agilacagi

panelin biiyiiliiglinden biiyiik olmaktadir. GeoEtrim’de panel lizerinde goriintii kaydirilarak
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veya goriintiiye yakinlasma yada uzaklagsma yaparak goriintii tizerinde ¢alisilmaktadir. Bu tiir
yazilimlarda kullanicilar sadece goriintliniin belli bir kisminda ¢alisabilmektedir. Bdylece bazi
durumlarda goriintiiniin tamamina hakim olunmayabilmektedir. Kullanic1 goriintiiye tam
hakimiyetini saglamak i¢in Sekil 3.13’de goriildiigii gibi takip paneli gelistirilmistir. Bu panel
ile goriintiiniin en-boy orani korunarak kiiciiltiilmiis bir hali ana pencereye yerlestirilmistir.
Ayrica kirmizi1 bir dikdortgen gerceve ile anlik ¢calisma alani kiigliltiilmiis goriintiiniin tizerinde

isaretlenmektedir. Boylece kullanict goriintiinii tamamini gorebilmekte ve ¢alisma alanini anlik

takip edebilmektedir.
A4 GeoBtrim (2018.01) - 0 X
File Tools Medules Help
L - | L X Active:(leg)de0l.tif (% = o 4= + 4 Wl @
" Propect: dmek_proe gor
W Image: MG _20161228_1107 1 pg
4 Ernce
i ey
|| GCPACP
@ B
]

) acpace

Row (pix): 4594 Column (pix): 2688 Toom Scale: 0,25

Sekil 3.13 GeoEtrim’de takip paneli.

Yazilimda takip paneli ile kullanict kolaylig1 saglanmasi hedeflenmistir. Takip panelinde
gorilintli, goriintiiniin acilacagl pencerenin yaklasik dortte birine sigacak oranda kiigiiltiilerek
gosterilmektedir. Bu panel kullanici tarafindan biiylitme veya kiiciiltme islemi yapilmasi
durumunda en-boy oranini koruyacak sekilde tasarlanmustir. Ornegim takip panelinin sagindan
biiyiitiilmesi durumunda meydana gelen goriintiideki ende olabilecek genislemeye karsin ayni
oranda goriintli boyda da genisleyerek panel yukar1 dogruda uzayacaktir. Bdylece en-boy orani

surekli korunacaktir.

Takip panelinde bulunan bir diger 6zelik te goriintii lizerine kirmizi ile ¢izilen takip gergevesidir

(Sekil 3. 13). Bu cergeve, goriintii panelindeki goriintiiniin siirlarinin takip panelinde
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gosterilmesini saglamaktadir. Goriintiiniin kaydirilmasi veya yakinlasma/uzaklagsma yapilmasi
durumunda takip panelindeki c¢erceve yenilenmekte; boylece anlik c¢aligma alam
goriilebilmektedir. Cercevenin yeri goriintii panelinin sag iist kosesindeki (orijin) goriintii
koordinatlarinin basit bir oran hesab1 ile takip panelinde karsilik gelen koordinatlarinin

hesaplanmasi ile bulunur.

A(Takip Paneli)

A = 3.3
oran - A(Gorinti Paneli) (3-3)

Fx = Sx *x Apran
(3.44a,b)

Fy =Sy * Aoram

Fw = (Iw x Agran) / ¢
(3.5c¢,d)

Fh = (Ih* Aoran) / ¢

Gorilintli panelinin sag iist kdsesi baslangi¢ noktasidir. Bu noktadan itibaren panelin en ve boy
uzunluk miktarina gore goriilen kisim kullanicinin ¢aligma alanidir. Caligsma alaninin baslangi¢
noktasi kayma ¢ubuklarinin goriintiiniin enindeki ve boyundaki kayma miktarlari ile belirlenir.
Calisma alanin genisligi ve uzunlugu da goriintli panelinin genisligi ve uzunlugu kadardir.
Calisma alaninin takip panelindeki kiiciik goriintiide ¢izilebilmesi i¢in bu iki panelin alanlar
oranlanmalidir. (3.3) numarali bagmtida takip panelinin alani, goriintii panelinin alanina
boliinmesi ile aralarindaki oran bulunmaktadir. Bu oran goriintii panelindeki en boy kayama
miktarina ¢arpilmasi (3.4 a, b) ile takip panelindeki kiiclik goriintiiye karsiligir hesaplanmis
olmaktadir. Calisma alanin takip panelindeki genisligi de (Fw, Fh) yine ayni sekilde goriintii
panelinin en ve boy uzunluklarinin (/w, Ih) paneller aralarindaki oranla ¢arpilmasi (3.5 ¢, d) ile
bulunmaktadir. Burada goriintiiniin yakinlasma ve uzaklasma oranini da (¢) hesaba katilmasi
gerekmektedir. Calisma alaninin takip panelindeki karsiliginin oranlanmast ile ilgili gelistirilen

algoritmanin 6zet kodu Sekil 3.14’de verilmektedir.
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// takip paneline karsilik gelen ¢alisma alani ¢ergevesi

double follow_x, follow_y, follow width, follow_height;

// kayma miktarina gére takip panelindeki ¢alisma alaninin baglangi¢ noktasi belirlenmesi
follow x = HScrollBar * A_rate;

follow _y = VScrollBar * A rate;

// kayma miktarina gore takip panelindeki ¢calisma alaninin en boy uzunlugunu belirlenmesi
follow width = img_ width * A rate;

follow_width = follow_width / ZoomScale; // ZoomScale = él¢ek

follow_height = img_height * A rate;

follow_height = follow height / ZoomScale;

Sekil 3.14 Caligsma alaninin takip panelindeki karsiliginin oranlanmasi ile ilgili gelistirilen
algoritmanin 6zet kodu.

3.2.1.5 Projelerin Saklama

GeoEtrim, projelerin saklanmasinda metin dosyasi yerine diiglim yapilarindan olusan
gelistirilebilir isaretleme dili (XML: eXtensible Markum Language) yapisim1 kullanmaktadir.
XML, hiyerarsik bir veri yapisinda dizilen diiglimlerden olusur (Bray vd. 2008). XML yapis1
C# tarafindan desteklendiginden biitiinlesik bir kodlamaya olanak verir. Bunun yani sira XML
metin tabanli oldugundan kolay anlasilmaktadir ve giinlimiizde internet yapilarinin neredeyse

tamaminda ve bir¢ok yazilimda veri saklama islemlerinde standart olarak kullanilmaktadir.

XML yapisinda Oncelikle bir kdk (Root) olusturulur. Bu kdke bagli elemanlar (FirstChild)
tanimlanabilir. Her eleman kok gibi kendisine bagli yeni elemanlar olusturabilir. XML’in bu
ozelligine diiglim (Nodes) yapis1 denir. Ayrica her diigiim i¢in sinirsiz niteleyici tanimlana

(attribute) bilmektedir. XML’in bu diigiim yapis1 Sekil 3.15°te gosterilmistir.
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ChildNode
Root Element

(kok elemant)

t ParentNode

FirstChild ~<€—— Element
(Eleman)
f ChildNode
ParentNode
Element
(Eleman)
ParentNode f ‘ ChildNode
Element
(Eleman)
PerentNode f ‘ ChildNode
Element
LastChild <—
(Eleman)

Sekil 3.15 XML diigiim yapisi.

GeoEtrim’in XML yapisinda, proje ve o projeye ait goriintiiler, goriintiilere ait YKN/BDN
verileri ve tlim bu verilerle iligkili meta verilerin diizenli bir sekilde saklanmaktadir. Cizelge
3.1’de Geoetim’in XML yapis1 gosterilmistir. Cizelge 3.2°de bulunan niteleyicilere (attribute)
ait aciklamalarda Cizelge 3.3’te verilmistir. Sekil 3.16°’da da GeoEtrim ile saklanmis 6rnek bir

projenin metin goriiniimii verilmistir.

Cizelge 3.1 Geoetim’in XML yapist.

Diigiim derecesi | Diigiimiin ad1 | Diigiim niteleyicilerin adlari
. Project name ve
1. derece (first) Project Information
7 derece Image name, hr@f, bants, width,
height ve id
PointID, PointType, Row,
3. derece gcp Column, X, Y, Z, StdRow,
StdCol, StdX, StdY ve StdZ
PointID, PointType, Row,
3. derece icp Column, X, Y, Z, StdRow,
StdCol, StdX, StdY ve StdZ
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Cizelge 3.2 GeoEtrim’de
niteleyiciler(attributes) hakkinda kisa agiklamalar.

XML halinde saklanan bir projenin

diigiimlerinde

ki

Project name | Projenin adi

Information Proje hakkinda bilgi

name Goriintii adi

href Goriintiiniin yolu

bants Goriintlideki bant sayis1

width Goriintiiniin eni

height Gorlintlinlin boyu

id GOriintiiniin seri numarast

PointID Noktanin seri numarast

PointType Noktanin tipi

Row Noktanin goriintiideki satir koordinati
Column Noktanin goriintiideki siitliin koordinati
X Noktanin X koordinati

Y Noktanin Y koordinati

Z Noktanin Z koordinati

StdRow Noktanin satir standart sapmasti
StdCol Noktanin siitiin standart sapmasi
StdX Noktanin X koordinatindaki hatasi
StdY Noktanin Y koordinatindaki hatasi
StdZ Noktanin Z koordinatindaki hatasi

<?xml version="1.0" encoding="UTF-8"?>
<Project Project_ name="" Information="">
<Image name="" href="" bands="" width="" height="" id="">
<gcp PointID="" PointType="" Row="" Column="" X=""Y="" Z="" StdRow="" StdCol="" StdX=""
StdY="" StdZ="" />
</Image>
</Project>

Sekil 3.16 GeoEtrim ile saklanmis 6rnek bir projenin metin goriiniimi verilmistir.

3.2.2 YKN/BDN Toplama Penceresi

GeoEtrim’de kullanish bir YKN/BDN toplama penceresi tasarlanmaya g¢alisiimistir (Sekil
3.17). Bu ekranmi benzerlerinden ayiran dnemli bir 6zellik, kiiglik bir goriintii penceresinde
noktalar1 gostermesidir. Boylece kullanici nokta dagilimmin son halini kolaylikla gorebilir.
Ayrica diizeltilen nokta (edit/delete) pencerede farkli bir renkte (standart olarak sar1 renkte)

gosterilmektedir.

40



A GCP & ICP Collection - m} X

Manual Load
working Image: image.tif GCP/ICP Browse
Load
Point Info Distribution of Points
Point ID: 32 #GCP= 75
Point type Control w| #ICP= @
Row (pix): 6274,125 +/- |@ | P
column (pix): [327 +-la | p
Easting (X): |393164,5992 +-la | ™
Norting (Y): |4588121,0856 +-[g | m
Height (2): 13,9 +/= 10 | W
oK [0 Auto locate Point settings
Point 3 Image Ground
1D Row X (
26 ] | 6585,625 i 144,500 | 392845,721 | 4587479,829 | 157,964
27 Control 6273,579 131,518 392687,776 4588026,791 183,899
6364,638 645,894 393943, 681 4sgse1s,588 || 283,919
— Sohich 99| _sseeias o0
| m,
37 Control 5747,716 783,457 393949,347 4589587535 76,219
42 “Control 7185,428 1329,555 | 395993,199 4586269,431 | 255,663

Sekil 3.17 YKN/BDN toplama penceresi goriiniimii.

Bu penceredeki herhangi bir noktanin ana penceredeki konumunu otomatik bir sekilde
kullaniciya sunabilmesi i¢in “auto locate” adiyla bir secenek sunulmustur. Bu segenek isaretli
olursa bu pencerede secilen herhangi bir noktaya gore ana penceredeki goriintii, secilen nokta
ortalanacak sekilde kayacaktir. Bunun icinde ana penceredeki, goriintii panelinde kayma
cubuklarinin (ScrollBar) kayma miktar1 hesaplanmalidir. “Goriintii koordinatlarinin okuma
ozelliginin gelistirilmesi” bagliginda goriintii panelinden, kayma c¢ubuklarinin kayma
miktarlarim1 dikkate alarak nasil goriintiinlin satir ve siitiin degeri okunabileceginden
bahsedilmekteydi. Esasen bu “auto locate” oOzelligiyle “goriintii koordinatlarinin okuma”
Ozelliginin matematiksel olarak tersi gelistirilmistir. “auto locate” oOzelliginde daha 6nce
toplanmis goriintli koordinatlarinin goriintiide yerini ¢aligma alaninda gdsterebilmek igin
goriintii  panelindeki kayma c¢ubuklarinin  kayma miktari, goriintii koordinatlariyla

hesaplanmaktadir. Bu hesaplanmanin matematiksel bagintis1 asagida verilmektedir

Sey=r—1,/2
-1, /2 (3.6 a,b)
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(3.6) numarali bagmtida gorlinti panelindeki kayma ¢ubuklarinin kayma miktar
hesaplanmasinda, goriintiiniin satir ve siitiin (» ,¢) degerlerinden goriintii panelinin en ve boy
uzunluklariin yarisi ¢ikarilmaktadir. Bu ¢ikarilma islemi secili noktay1 goriintii panelinde orta
merkez de gosterebilmek i¢in yapilmaktadir. Eger kayma miktarlar1 dogrudan goriintiiniin satir
ve siitlin degeri olacak sekilde verilirse, secili nokta goriintii panelinin sag lst kosesinde
goziikiir olacaktir. Buda goriintiiniin ¢alisma alaninin merkezinden en uzak noktadir. Bunu
onlem ve boylece kullanicinin dogrudan noktay1 caligma alanin merkezinde goérebilmesini
saglamak i¢in kayma cubuklar1 noktay1 ortalayacak sekilde ¢ekilmistir. “auto locate” 6zelligi
ile kayma cubuklarinin kayma miktarinin hesaplanmasi ile ilgili algoritmani 6zet kodu Sekil

3.18 verilmistir.

int HScrollBar, VScrollBar; // Gériintii panelindek kayma ¢ubuklarinin kayma miktart
HScrollBar = realx - (img_width / 2); // realx, realy = Goériintiinii satir ve siitiin degeri
VScrollBar = realy — (img_height / 2);

//img_width, img_height = Gériintii panelinin en ve boy uzunlugu

Sekil 3.18 “auto locate” 6zelligi ile kayma ¢ubuklarinin kayma miktarinin hesaplanmasi ile
ilgili algoritmani 6zet kodu.

3.2.3 Nokta Disar1 Aktarma Penceresi
Nokta disa aktarma penceresinde, genis bir dosya kaydetme segenegi tasarlanmistir (Sekil

3.19). Disa aktarilan dosyalar “gcp” uzantili metin dosyalaridir. Ige aktarma isleminde ise

“txt” veya “gcp” uzantili uygun yapida metin dosyalar1 okunabilmektedir.
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Working Image
|D:\Temjoh.JPG "

|4 Point 10 Options
Point Type 3 Number of decimal place for coordinates: 3
Row

Column Number of decimal place for std values: 3 |2
|[#] Easting (X)

Northing () l
[/] Height () X
Std Row
|lv] 5td Column Tl e Separate columns by: Tab v
Std X e

5td Y 7 Add Columns Title
Std Z ICP

Separator for decimal place: |. dot v

Location: | | Browse

Name: | | Export

Sekil 3.19 Nokta disar1 aktarma penceresi.

Nokta disar1 aktarma penceresi ile kullanici nokta bilgilerini dosyaya aktarma siitiin sirasini ve
aktarmak istedigi boliimii segebilecek sekilde tasarlanmistir. Ayrica sayi igeren bilgilerde
ondalik kisminin ka¢ basamaktan olusacagini yine bu pencereden ayarlanabilmektedir.
Dosyada ondalik kisma gegerken virgiil veya nokta ile gosterme secenekleri de pencerede
sunulmustur. Yine bu pencere ile disa aktarilan dosyanin siitiin araliklari; bosluk, egik ¢izgi (/),
alt c¢izgi (), sekme (tab) ve noktali virgil (;) olmak iizere 5 farkli bigcimde
olusturulabilmektedir. Dosyaya sadece yer kontrol noktalarini veya bagimsiz denetim
noktalarini aktarila bildigi gibi her ikisi de ayni dosyaya aktarilabilmekte miimkiin olmaktadir.
Aktarilan dosyaya siitunlarin baslik bilgileri de istege bagli eklenmektedir. Disar1 aktarilan
“.gep” uzantili dosyalar “text” yapidadirlar. Ancak “.gcp” uzantili farkli farkli yapida tiim
dosyalar1 GeoEtrim igine aktarmak miimkiindiir. Ciinkii “.gcp” dosya uzatilarin1 okuma
isleminde program yapinin nasil hazirlandigin1 anlayabilmesi i¢in dosyanin en {ist satirina

“Import sequence” ismiyle dosyanin yapisini ifade eden ice aktarim kodunu eklemektedir (Sekil

3.20).
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1 Import sequence: 3/1/0/1/2/3/4/5/6/-1/-1/-1/-1/-1/
2 Image file: IMG SPOT6 P 201805150822572_ S5ENW_SPOT6 20180528 135213120spTnljadmy l.tif

8 PointID PointType Row Column X T Z

£ 1 Control 10760.000 3900.7350 41.3%% 31.663 180.040
o 2 Control 10723.750 3902.750 41.400 31.663 185.980
) 14 Control 10033.500 5520.750 41.410 31.694 195.900
: 15 Control 9559.500 5587.500 41.411 31.6%5 201.820
18 Control 9689.750 6038.750 41.415 31.704 232.970
1 20 Control 9585.000 5885.750 41.417 31.701 172.930
11 21 Control 10748.500 €416.250 41.3%% 31.711 3el.560
12 z4 Control 10517.750 6375.000 41.402 31.710 393.540
13 25 Control 9736.250 6531.250 41.414 31.713 247.440
14 26 Control 9803.500 €787.250 41.414 31.718 191.1%0
15 27 Control 9466.500 6685.250 41.418 31.71le 21&.230
1 28 Control 9463.500 T4€59.750 41.41% 31.731 237.110
17 31 Control 9178.250 T013.750 41.423 31.72z2 68.170
1 35 Control §910.500 T350.000 41.427 31.72% 173.9%0
1 37 Control §528.000 g.250 41.433 31.731 105.16€0
2 42 Control 10518.750 . 000 41.403 31.756 289.
21 43 Control 9015.750 -500 41.425 31.745 273.¢
22 48 Control 9256.250 .000 41.422 31.758 245,
2 47 Control 9lea.000 -250 41.423 31.761 284,
2 50 Control 9082 .500 -250 41.424 31.748 304.
25 &1 Control 8985.500 .S00 41.426 31.744 266,
2 52 Control 90683.250 . 000 41.425 31.73% 254,
27 54 Control 8624.750 . 000 41.431 31.733 129
2 &5 Control 858E.000 .000 41.432 31.734 123,
2 8 Control §372.500 -250 41.435 31.745 36.
59 Control 8268.250 7.000 41.437 31.742 37.

Sekil 3.20 GeoEtrim’de 6rnek bir projede digar1 aktarilan “.gcp” uzantili nokta dosyasinin
text yapida goriintimii.

Sekil 3.20°de goriilen “.gcp” uzantili 6rnek projede en iist satirda “Import sequence” ile ifade
edilen boliim dosyanin yapisini ifade eden i¢e aktarim kodudur. Bu kod sirasiyla; nokta verilerin
kacinci satirdan sonra bagladigi, nokta ondalik kisimlarinin hangi isaretle ayrildigi, siitiin
bosluklarinin hangi isaretle ayrildig1 ve nokta numarasi, tipi, satir, siitiin, x, y, z, ve standart
sapma degerlerinin kaci siitunda oldugu gosterilmektedir. Eger herhangi bir siitiin dosyaya
aktarilmamissa o siitiin sirasindaki rakam “-1” olarak koda yazilmaktadir. Boylece okuma
islemi bu koda gore yapilmaktadir. Ayrica bu dosyanin ikinci satirinda “Image file” bagligi ile

noktalarin ait oldugu goriintiiniin dosya isim bilgisi de eklenmektedir.

3.2.4 Nokta Iceri Aktarma Penceresi

Bu pencereye GeoEtrim’de farkli meniilerden erisilebilmektedir. Bunlardan ilki YKN/BDN
toplama penceresinin yiikleme paneli kismidir. Bu pencereye diger ulagsma meniileri de ana
pencereden veya GeoTransform penceresinden acilabilen bos goriintii agma penceresinden
acilmaktadir (Sekil 3.21). Bos goriintii agmanin amaci kullanicilarin dogrudan nokta verileri ile

caligabilirligini saglamaktir.
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A% Working without image X

Name: l I

GCP/ICP file: [ I Browse

Background color: |[IEETSEEN - |

Sekil 3.21 Bos goriintii agma penceresi.

Bos goriintii agmak veya var olan goriintiiye disardan dosya aktarmak amaciyla nokta igeri
aktarma penceresi tasarlanmistir (Sekil 3.22). Bu pencerede disarda olan dosya okunarak bir
tabloda 6n izlenebilir sekilde kullaniciya gosterilmektedir. Kullanic1 verilerde herhangi bir

kayiklik veya hata olmadigini inceleyip aktarma islemini onaylayabilir veya iptal edebilir

A4 Import = X
Import and Close Working Image: empty
Row Count= 19
Point ID ?;: faoge g Gond  Gond  CSomd goRw  dCd SdX 4y sz
BRI coo (6505625000 1445000 |392845721... [457a7se2.. 157964000 0000 0.000 0.000 0.000 0.000
7 Contl  |6279579.000 | 131518000 |392687776... |458802679... |183099.000 |0.000 0.000 0.000 0000 0000
2 Control 6274125000 |327.000  |39316459.. |458812108.. |139.000  |0.000 0000 0.000 0000 [0.000
% (Cortol  |598889.000 |653914000 |393766461.. |450894282.. 140955000 0000 0000 (0000 (0000 |0.000
¥ [Conrl  |5747716.000 | 783457000 |393943347.. |458958753.. (76219000 0000  [0000 (000D 10000  |0000
a [l |6153986.000 | 1180022.000 |395094221... |458874168... |240741.000 |0.000 10,000 0000 10.000 10000
% [Conrl  |6332696.000 |1602263.000 | 396213867... |458835064.. 1211386000 10000 0000 (0000 10000 0000
a7 |comml  [634475.000 |17155000 |396460817.. |456048456... |261206.000 |0.000 0,000 [0.000 10.000 10,000
50 (ool |6217875.000 | 12835000 | 395364093... |458862427... |27133.000 |0.000 |0.000 0000 10,000 10000
51 Cortl  |612467000 | 115254000 |395012427.. |458879354.. (233544000 10000  |0000  |000D (0000  |0000
52 (Control  |6149559.000 |962516.000 |394573782.. |450867307.. 221634000 (0000 10000 0000|0000  |0000 v
L4 >

Sekil 3.22 Nokta ige aktarma penceresi.

“.txt” uzantilar1 nokta dosyalar1 icin metin dosyasinin belli standartta hazirlanmig olmasi
gerekmektedir. Bu standart sirasiyla: Noktanin numarast, tipi ve satir, siitiin, X, y, z degerleri ile
bunlarin standart sapmalarindan olusmalidir. Bu siitunlar aras1 da “tab” ile ayrilmalidir. Ornek

bir nokta dosyasi Sekil 3.23’de sunulmaktadir.
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32 Control €274125.000 327.000 3931€45992.000 4588121085€.000 139.000 0.000 0.000 0.000 0.000 0.000
35 Control 558885%.000 €53914.000 3537€64€13.000 45885428227.000 140%55.000 0.000 0.000 -0o00 0.000 0.000
37 Control $74771€.000 783457.000 3939453473.000 45895875353.000 76219.000 0.000 0.000 0.000 0.000 0.000
43 Control €153986€.000 1180022.000 3550942211.000 4588741€8€7.000 240741.000 0.000 0.000 0.000 0.000 0.00
46 Control €382696.000 1€02263.000 356213867.000 45883506459.000 211586.000 0.000 0.000 0.000 0.000
47 Control €34475.000 17155.000 3964€08175.000 45884845683.000 26128€.000 0.000 0.000 0.000 0.000
50 Control €217875.000 12835.000 3953€40933.000 .000 27133.000 0.000 0.000 0.000 0.000
51 Control €1294€7.000 115254.000 3550124277.000 -000 233544.000 0.000 0.000 0.000 0.000
52 Control €149559.000 962516.000 3945737825.000 4588€730742.000 221634.000 0.000 0.000 0.000 0.000

54 Contro 5823385.000 830452.000 3940988071.000 4589420208.000 96895.000 0.000 0.000 0.000 0.000
55 Control 580659€.000 ©S82658.000 394213034€.000 458948286€24.000 90911.000 0.000 0.000 0.000 0.000
58 Control 563772.000 120€107.000 354859576.000 4590024€73€.000 4214.000 0.000 0.000 0.000 0.000
€2 Contro $510322.000 1469331.000 3954548408.000 45904402343.000 1%15.000 0.000 0.000 0.000 0.000
63  Control $75875.000 1427125.000 39548525.000 45898140309,.000 7833.000 0.000 0.000 0.000 0.000
€6 Control €135547.000 1€30358.000 3961€1887.000 45885586€6€1.000 114455.000 0.000 0.000 0.000 0.000
€7 Control 530275.000 1705.000 3559025644.000 459103783%8.000 1253.000 0.000 0.000 0.000 0.000
€8 Control S886113.000 1930957.000 39€7500644.000 4589700977€.000 14135.000 0.000 0.000 0.000 0.000
71 Control 6456187.000 17386€25.000 3965€88415.000 458822049%6.000 28799%.000 0.000 0.000 0.000 0.000 0.000

Sekil 3.23 “.txt” uzantili GeoEtrim’de ¢alisacak nokta verileri

3.3.5 GeoTransform Penceresi

Bu alt yazilima GeoEtrim’in ana penceresindeki alt yazilimlar sekmesinden erigim
saglanmaktadir. GeoEtrim’in MATLAB siiriimiinde dort farkli alt yazilim mevcuttur (GeoSpot,
GeoTransform, Geo3ol ve GeolP). Ancak GeoEtrim’in bu tez kapsamindaki siirimiinde
hesaplama yapilabilen tek alt yazilim GeoTransform’dur (Sekil 3.24). GeoTransform alt
yaziminin ara yiizii islem 6zelligi ve rapor olmak iizere iki farkli panel ve bir nokta tablosundan
olusmaktadir. Nokta tablosundaki her noktanin ilk siitununda isaretleme kutusu (checkBox)
eklenmistir. Isaretleme kutusu noktay: isleme dahil etme veya etmeme secenegi olarak
gelistirilmistir. Boylece hesaplama islemi yapilirken program sadece isaretli noktalar1 isleme
alacaktir. Isaretli olmayan noktalar hesaba katilmayacaktir. Ayrica nokta tablosunda siitunlar
strastyla: noktanin numarasi, tipi, uysumsuzluk sonucu, satir koordinati, satir diizetmesi, siitun
koordinati, siitun diizetmesi, X, Y, Z koordinatlaridir seklindedir. Bu siitunlardan, uysumsuzluk
Olcii testi, satir diizetmesi ve siitun diizetmesi islem oncesinde (ilk program acildiginda) bos

gelmektedir. Bu siitunlar yapilan islem sonucuna gore iclerine veri yazimi gerceklesmektedir.
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4 GeoTransform — X

Working Image Report

Metrics (pixel) Show image:
IMG_SPOT6_P_2@1885158822572 SEN_SPOT6_207 mr= 1574 [w]- e.ee — 10 Pixel
4. vector scale= 150.8 &
mc= £3.83 [vel= e.ee
vector thicknees= 1.0 [
properties mo=  $11.45 [wl= e.ee
el - point sizes 5.5 |2
iz Polingaisl TR ~
i §|empq&g“|g| = Points (processed/total)= 35/53 R gy T
. Degree of freedom= 152
Eaneu e
Blunder test rmel distribution v All parameters are valid.
Apriori g.= 1.8 = vector scales 158.8 =
vector thicknees= 2 &
Rapor paneli
R f
Apply Export GCP/ICP Load

Outlier

~

I BN

2.000 Control M 10723.750 3.76 2.750 41.400 31.663 185.988

14.6060 Control v 10033 .560 3.37 5528.758 8.93 41.410 31.694 195.986
15.880 Control b 9959.588 3.e7 5587.580 2.59 41.411 31.695 281.628
18.0088 Control v 9589.758 7.55 5@38.758 -2.45 41.415 31.784 232.978
20.000 Control F 9585.880 190 5895.758 -8.55 41.417 31.781 172.938
21.000 Control v 18748.50@ 19.77 6416.250 -8.68 41.339 31.711 361.568
24.000 Control Row & Column 18517.75@ 25.81 6375.080 -8.88 41.4092 31.718 393.548
25.000 Control v 9736.250 9.25 6531.250 -1.25 41.414 31.713 247.448
26.000 Control « 9803.500 -2.@6 6787.250 -2.48 41.414 31.718 191.19@
27.000 Control v 9466.500 4.38 6685.25@ -2.82 41.418 31.716 216.230
28.000 Control « 9463.500 5.6 7469.750 -1.39 41.419 31.731 237.110
31.e00 Control v 9178.250 -15.72 7013.750 @.97 41.423 31.722 68.17@
35.000 Control v 891@.588 e.19 7350.000 -1.74 41.427 31.729 173.990
37.000 Control v 8528.000 -8.73 7458.250 -1.98 41.433 31.731 109.160
42.000 Control v 1@518.75@ e.77 8769.800 -9.95 41.483 31.756 289.230
43.060 Control v 9815.750 18.39 8184.508 -3.38 41.425 31.745 273.878
46.060 Control M 9256.256 1.50 8889.080 -3.26 41.422 31.758 245.238
47.060 Control v 9166.0600 5.48 9@841.256 -2.28 41.423 31.761 294.528
58.080 Control b 9882.588 13.48 8355.250 -4.08 41.424 31.748 384.498
51.080 Control v 8985.588 9.62 8133.5088 -4.08 41.426 31.744 266.668
52.080 Control b 9863.258 6.94 7859.880 -2.82 41.425 31.739 254.758
54.000 Control v 8624.750 -4.85 7553.800 -1.51 41.431 31.733 129.878

Sekil 3.24 GeoTransform alt yaziliminin goriiniimii.

GeoTransform alt yaziliminin islem o6zelligi panelinde kullanici doniisiim yOntemini

secebilmektedir. Bu panelde tercih edilebilecek doniisiim yontemleri:

1. Similarity (Helmert-Benzerlik)
2. Affine (Afin, 1. derece polinom)
3. Polinomial (Polinom)

a. Birinci derece (Affine 2D)
b. Ikinci derece

Uciincii derece

e

d. Dordiincii derece
e. Besinci derece
4. Affine projection (Afin izdiisiim)
a. Generic affine projection (Genel model)
b. AP for OrbView — 3 (OrbView-3 icin uyarlanmis model)
c. AP for IKONOS & QuickBird (IKONOs ve Quickbird i¢in uyarlanmig model)
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5. Projective (Projektif)
6. DLT
7. RFM (GCP dependent, YKN bagiml1)
a. Birinci derece
b. Ikinci derece
c. Ugiincii derece
Seklindedir. Bazi matematiksel koordinat doniisim modellerinin birden fazla tiiri
olabilmektedir (Polinomial, Affine projection ve RFM). GeoTransform’da bu matematiksel
modellerden biri secilirse program matematiksel modelin tlirlinii isteyecek sekilde

gelistirilmistir (Sekil 3.25).

Properties Properties

mat model: Affine projection w Mat model: Affine projection w
Similarity (Helmert)

Model ID: affine (1st degree polynomial) mModel ID: Generic affine projection
Polinomial

Generic affine projection

Affine projection AP for orbview - 3
Blunder test: E[?jecn‘e glunder test: |AP for IKONOS & QuickBird
- RFM (GCP dependent)
Apriorl G.= = b Apriori o.= 1.2 =

Apply Hormalization:

Apply Normalization:
B.108 |=
B.188 |2
5 =
5 =
Apply Export GCP/ICP Load
Apply Export GCP/ICP Load
a) Doniistim modelleri se¢imi b) Tiirli olan doniisiim modelleri segilirse

program tiiriinii segmenizi isteyecektir.

Sekil 3.25 Doniisiim modelinin GeoTranform’da se¢imi.

Matematiksel doniisiim yontemlerinden dongiisel yontemler (projektif, DLT ve RFM) i¢in
kullanic1 tercihinde bir esik deger ve en fazla dongii sayis1 (dongii iist sinir, tekrarlama degeri)
belirlenebilmektedir. Dongiisel yontemlerde kullanicinin belirledigi esik deger ve en fazla
dongii sayis1 dongii islemini sinirlandirir. Dongilisel islemde tekrarlanan dongii belirlenen en
fazla dongii sayisin1 gecemez. Yine ayni sekilde art arda dongtilerden hesaplanan koh (karesel

ortalama hata) farki esik degerini altina diistiigiinde dongii tekrar etmez.
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f(ro,co) = Mp(1)
f(r,c1) =moy Amy = myn) — Mo eger|A;| > esik deger (devam)
(3.7)

f(rn—ll Cn—l) = My Amn—l = Mym) — Myn-1) egerIAll < €$ik deger

(3.7) numarali bagintida goriildiigii gibi ikinci dongiiden itibaren koh’un (karesel ortalama hata)
bir onceki dongilideki koh’tan farki (Am), kullanici tarafindan belirlenen esik degerle
karsilastirilir. Eger fark esik degerden kiigiik veya esitse dongii durur. Aksi takdirde dongii
devam eder. Ancak dongii sayisi belirlenen dongii iist sinirina ulagsmasi durumunda program

Am ile esik deger karsilastirmasi yapmadan iglemi sonlandirir.

Ayrica “Apply Normalization” se¢enegi ile noktalarin goriintii ve nesne koordinatlar1 her biri
kendi tiirtinde +£1 aralifina oranlanarak normalizasyon islemi de yapilabilmektedir. Boylece
kiitli koralasyonu etkisi giderilerekte islem yapilabilmektedir. Sekil 3.26’da normlandirma

isleminin algoritma 6zet kodu sunulmaktadir.

Il Normlandiracak dizide her bir eleman igin ayni iglem yapimall.

for (1=0;1<ref array Length; i++) /ref array Length = elaman sayisi
new_array[i] = (2*ref array[i] - max_value - min_value) / (max_value -
min_value) ; / max_value = en biiyiik elamanin degeri

// min_value = en kiiciil elamanin degeri

return new_array; // en son olusan dizi

Sekil 3.26 Normlandirma isleminin algoritma 6zet kodu.

Sekil 3.26°de gerceklestirilen normlandirma islemi GeoTranform da gergeklestikten sonra hata
katsayilarinin ve diizetmelerin isleminin geri yapilabilmesi i¢in 6l¢ii kiimesinde tam ters islemi

olan geri normlandirma islemi gerceklesmektedir (Sekil 3.27).

for (i=0;1<ref array Length; i++)
new_matrix[i] = (ref array[i]*(max_value - min_value) + max_value + min_value)/2;
return new_array

Sekil 3.27 Geri normlandirma igleminin algoritma 6zet kodu.
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Isleme giren goriintii koordinatlarinda uyusumsuz 6l¢ii testi de yapilmaktadir. Bu test
degerlerinden hangilerinin diger degerlere gére uyusumsuz oldugunu gosteren islemdir. Islem
ozelligi panelinde normal ve t dagilimlar1 olmak iizere iki farkli uyusumsuz 6l¢ii testi secenegi
sunulmustur. Uyusumsuzluk 6l¢ii testi satir ve siitiin da ayr1 ayr1 hesaba alindigi i¢in bir nokta
hem satir hem siitun uyusumsuz olabilecegi gibi sadece satirda veya sadece siitunda uyusumsuz
oOl¢ii olabilir. Nokta tablosunda her nokta i¢in uyusumsuz 6l¢ii varsa eger hangi 6l¢ii oldugu

Sekil 3.28°de oldugu gibi gosterilmektedir.

\ , I ’ ) A

15,008 (ontrol i 9939, 500 .47 5387.5680 8,59 41411 31.6% 291628
18,608 (ontrol / 9589.738 1.5 6838.738 -1.45 41.415 LT 131979
29,000 (ontral { 9585, 0o 1.2 5895.758 -8.55 41417 L.l 172.938
21009 (ontral I 8.7 416,258 -0.68 41,39 i 361,568
24,50 (ontrol Row & Column b 5.8 6375.080 -0.88 41,401 1718 393,540
25,608 (ontrol / 9736.258 .55 6531.258 -1.15 41.414 .13 47449
25,000 (ontral { 9883, 500 -1.86 b787.258 -0.48 41.414 718 191.198
21,000 (ontral / S456.560 4.38 6685.258 -1.82 41.418 31716 216.239

Sekil 3.28 Satir ve slitunda uyusumsuz olan noktanin gosterimi.

Rapor panelinde islemler ile ilgili ¢iktilar mevcuttur. Bu panelin 6l¢iit boliimiinde noktalarin
satir (my), siitun (mc) ve tiimiinde (mo) koh ile satirin ([v+]) ve slitunun ([vc]) diizeltme toplam

degeri ([vv]) sunulmaktadir. Sekil 3.29°da rapor panelinin 6l¢iit boliimii sunulmustur.

Metrics (pixel}
mr= #3237.33 [vr]= @.88

mc= +2382.74 [vc]= @.ee

mo= +2842.34 [wvw]= 36.18

Points (processed/total)= 99/99
Degree of freedom= 194

Same parameters are invalid.

Sekil 3.29 Rapor panelinin 6l¢iit bolimii.

50



Sekil 3.29°da goriildiigli gibi rapor panelinin, sadece doniisiim iglemine giren ve toplam nokta
sayist (processed/total), serbestlik derecesi (Degree of freedom) ve parametre anlamlilik testi
sonuglar1 da kullaniciya sunulacak sekil programa eklenmistir. Parametre anlamlilik testi,
secilen doniisiim modeli i¢in anlamsiz (gereksiz) olan parametreleri veya katsayilar1 bulmak
icin kullanilir. Eger matematiksel modelde boyle bir katsay1 programin arka planinda tespit
edildiyse mavi bir link ile Sekil 3.29°da goriildiigii gibi olacaktir. Sekil 3.30°da 6rnek bir

parametre anlamlilik testinin sonucunun GeoTransform’da gosterimi sunulmaktadir.

Information

=T

| 18750.200

18723.750 4332 4
18833 .560 3258_.5 4
9959500 3228.80 4
9689 .758 : 28951 .95 4
9585 . 690 871.43 5895.750 3102.04 4
18748.500 -738.11 6416.250 2309.35 4
18517.750 -438.55 6375.000 2413.87 4
9736.258 448.47 6531.250 2543.12 4
9803 .500 261.76 6787.250 2320.80 4
9466500 785.17 6685.258 2507.17 4

Sekil 3.30 Ornek bir parametre anlamlilik testinin sonucunun GeoTransform’da gosterimi.

Islem sonucunda noktalarin satir ve siitun diizeltmeleri iki farkli vektdr ¢izimi ile gdsterilmistir.
Bunlardan ilki, goriintii koordinatlarinda hata vektorleri seklinde Sekil 3.24 a’da goriildiigii gibi
gosterimidir. Burada Sekil 3.24 b’de goriildiigli gibi goriintliyli gosterime dahil etmemekte
mevcuttur. Ayrica gorlintli cergevesinin iistiinde gosterilen piksel 6lgegi i¢in piksel say1 degeri
(10 piksel) kullanici tercihiyle degistirilebilir. Kullanici tercihinde vektorlerin olgegi, cizgi
kalinlig1 veya noktalarin biiyiikliigii de degistirmek miimkiindiir. GeoTransform’da bir diger
hata vektorii gosterimi ise Sekil 3.24 ¢’de goriildiigii gibi vektorlerin tek bir merkezde dagilimi
seklindedir. Kullanict bu vektorleri de belli bir sabitle ¢arparak gorsel agidan ayirt ediciligini

arttirabilir. Rapor boliimiinde kullaniciya verilen tiim bilgileri metin formatinda GeoTranform
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disini aktirilabildigi gibi gorsel vektor sonuglarini da goriintii formatlart halinde digar1 aktarmak

miimkiin olabilecek sekilde gelistirilmistir.

18 Pixel 10 Pixel

a) Gorlintiili, goriintli koordinatlarinda hata b) Goriintiisiiz, goriintii koordinatlarinda
vektorleri. hata vektorleri.

c) vektorlerin tek bir merkezden olan dagilimu.

Sekil 3.31 Noktalarda hata vektorlerinin GeoTransform’da gosterimi.

3.3.6 Gorsel Ayarlama Penceresi

GeoEtrimde kullanic1 tercihinde bazi bdliimlerde yazi tipleri, renkleri veya boyutlari
degisebildigi gibi nokta veya vektorlerde gorsel degisiklikler yapabilmek miimkiindiir. Bu
gorsel degisiklik ayarlar1 i¢i Sekil 3.32°de goriildiigii gibi gorsel ayarlama penceresi
gelistirilmistir. Bu pencerede yapilan degisikler program tarafindan saklanmakta, kullanicinin

GeoFEtrim’i kapatmasi veya bilgisayar kapatmasi durumunda da muhafaza edilmektedir.
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Kullanici tekrar GeoEtrim’e girmesi durumunda en son yaptig1 gorsel ayarlama ile programi
kullanmaya devam edilebilmektedir. Bunun i¢in GeoEtrim, gorsel ayarlama penceresinde var
olan tiim bilgiyi metin formatinda (.txt) yazilimin yiiklii oldugu klasore (path) kayit etmektedir.
Program calistiginda bu gorsel ayarlama ile ilgili tiim veri okunur ve gorsel ayarlamalar
gerceklestirilir. GeoEtrim’e varsayilan gorsel ayarlarda eklenmistir. Kullanic istegiyle gorsel
ayarlama penceresinden bu ayara da gitmek miimkiindiir. Ayrica GeoEtrim gorsel ayarlarin
yazili oldugu metin verilere ulasamadiginda veya dosya bozuk oldugunda da program bu
varsayilan gorsel ayarlara gore diizenlenecektir. GeoEtrimde yapilabilecek gorsel ayarlar su

sekilde siralanabilmektedir.

e GeoEtrim’in ana penceresin de goriintii panelin de toplanan noktalarin yazi tipleri, yazi
boylar1 ve yazi renkleri ile noktalarin yerlerini belirlemek icin ¢izilen ¢izgilerin kalinligi,
genisligi ve rengi

e GeoTranform ve YKN/BDN pencerelerinde bulunan nokta tablolarinin baslik satir ve veri
satir1 ayr1 olmak {izere yazilarin tipi, rengi ve boyutu ile bu satirlarin arka plan rengi

¢ YKN/BDN penceresinde bulunan mini goriintii panelinin arka plan rengi ve noktalarin rengi
ve genisligi

e GeoTranform penceresinde bulunan mini goriintli panelinin arka plan rengi ve noktalarin

rengi ve genisligi ile vektorlerin rengini bu pencereden degistirilebilmektedir.
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A Visual Settings

GCP/ICP Points GeoTransform

GCP ICP
Font type: |Cnnsolas v‘ Font type: |C|:|nsculas v|
Font size: 1@ = Font size: 1@ =
Font color: |.Red v‘ Font color: | Aqua v|
Point size: 23.8 = Point size: 23.8 =
Line width: 2.8 = Line width: 2.8 =
Point color: |.F{Ed ~ Point color: | Aqua w

Show GCP by Show ICP by

Type: Type:

ID: ID:

| GCP-427
Cancel Default Apply

Sekil 3.32 Gelistirilen gorsel ayarlama penceresi goriiniimii.
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BOLUM 4

UYGULAMA

GeoTransform ile gergeklestirilen 6rnek bir uygulama yapilmistir. Uygulama bolgesi olarak
Zonguldak ili merkezini kapsaya 27.05.2014 tarihli ve ve 2.5 m yer 6rnekleme aralig1 degerine
sahip GOKTURK-2 pankromatik uydu gériintiisii kullanilmistir. Uygun dagilmis 62 YKN,
gorilintiileri yardimiyla toplanmigtir. GeoTransform™un C# siirlimiiniin sonuglari, (Cam 2018)
tarafindan gelistirilen MATLAB siirlimiiniin sonuglar1 ile karsilastirilarak elde edilmistir.
Uygulama sonuglar1 Cizelge 4.1’de sunulmustur. Cizelge 4.1°de ki hesaplar normallestirme
yapilarak elde edilmistir. Burada dongiisel islemler i¢in dongii iist sinir1 “5” ve esik degeri de
“0.1” piksel olarak belirlenmistir. Dongiisel islemlerde, karesel ortalama hata sonuglarina

karsilik gelen dongii tist sinirt ve esik deger sonuglar1 Cizelge 4.2°de sunulmustur.

Cizelge 4.1 Calisma alaninda 2B normallesitirme yapilarak konum dogrulugu uygulama

sonugclari.

Yontemler mr Mc Mo
Benzerlik + 150.91 +176.53 +164.22
Afin (1° polinom) + 1.83 +5.58 +4.16
1° polinom (Afin) + 1.83 +5.58 +4.16
2° polinom +0.91 +4.67 +3.36
3° polinom + 0.89 +4.70 +3.38
4° polinom +0.77 +4.46 +3.20
5° polinom +0.71 +4.17 +2.99

Afin izdiisim
+1.81 +4.78 +3.61
Genel afin izdiistim

OrbView-3 i¢in gelistirilen model +0.97 +3.51 +2.57
IKONOS&QuickBird igin gelistirilen

+1.72 +4.78 +3.59
model
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Projektif +2.26 +5.11 +3.95
DLT +2.35 +3.96 +3.27
1° RFM +1.34 +3.10 +2.39
2° RFM +0.63 +1.11 +0.90
3° RFM +0.41 +0.29 +0.35

Cizelge 4.2 Calisma alaninda yapilan dongiisel islemlerde, karesel ortalama hata sonuglarina
karsilik gelen dongii st sinir1 ve esik deger sonuglari.

Yontem \ Dongii sayisi | Koh farki (Am)
DLT 2 0.00045

1° RFM 2 0.00006

2° RFM 2 -0.02132

3° RFM 3 -0.00882

Cizelge 4.1°de goriildiigii gibi Goktiirk-2 pankromatik uydu goriintiisiinde normallestirme
yapilan olciilerle elde edilen sonuglar inceldiginde satir, siitiin ve genel karesel ortalama hata
sonuclari en az olan doniisiim modelinin 2 derecelik RFM koordinat doniisiimii oldugu
gorliilmektedir. En kotli sonuglarda bu doniisiimlere gore benzerlik koordinat doniistimii
olmaktadir. Yine RFM doniisiime en yakin sonu¢ veren donilisim modeli afin izdiistim
koordinat doniisiimiiniin “OrbView-3” goriintiileri igin gelistirilen modelidir. Yine ayni
Olciilerle Cizelge 4.2°de elde edilen dongii sayisi ve esik deger tablosu incelendiginde, dongiisel
doniis modellerinin hig biri belirlenen (5) dongii iist sinirina gelmeksizin, esik degerin altina
ulastig1 goriilmektedir. Dongiisel modellerden 3 derecelik RFM modeli 3 dongiide esik degerin

altina ulasirken diger modeller 2 dongiide esik degerin altina diigmektedirler.

Zonguldak iline ait GOKTURK-2 pankromatik uydu goriintiisii kullamlarak uyusumsuz &lgii
testi de yapilmistir. Uyusumsuzluk 6l¢ii testi GeoTransform’da normal ve t-student dagiliminda
yapila bilmektedir. Cizelge 4.3’de t-student dagiliminda uyusumsuz Olgli testi sonuglari
sunulmaktadir. Ayrica yine bu goriintiide doniisiim modellerine ait parametre anlamlilik testi,

GeoTransform sonuglar1 Cizelge 4.4’de sunulmustur.
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Cizelge 4.3 Uygulamaya ait t-student dagiliminda uyusumsuz 6l¢ii testi sonuglari.

Yontem Nokta numarasi Uyusumsuzluk

Benzerlik Yok Yok
Afin (1° polinom) 299 Sadece siitunda
1° polinom (Afin) 299 Sadece siitunda
2° polinom 261 Sadece siitunda
299 Sadece siitunda
3° polinom 261 Sadece siitunda
299 Sadece siitunda
4° polinom 261 Sadece siitunda
299 Sadece siitunda
100 Sadece siitunda
160 Sadece siitunda
5° polinom 167 Sadece siitunda
261 Sadece siitunda
299 Sadece siitunda

Afin izdistim
249 Sadece siitunda
Genel afin izdlisiim
OrbView-3 i¢in gelistirilen 261 Sadece siitunda
model 299 Sadece siitunda
IKONOS&QuickBird i¢in
. 249 Sadece siitunda
gelistirilen model

o 119 Sadece siitunda
Projektif 299 Sadece siitunda
305 Sadece siitunda
26 Sadece siitunda
DLT 249 Sadece siitunda
299 Sadece siitunda
26 Sadece siitunda
1° RFM 249 Sadece siitunda
261 Sadece siitunda
299 Sadece siitunda
72° RFM 261 Sadece siitunda
299 Sadece siitunda
3° RFM 168 Sadece siitunda
258 Sadece siitunda
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Cizelge 4.4 Caligma alaninda yapilan uygulamaya ait doniisim modellerinin parametre
anlamlilik testi, GeoTransform sonuglari.

Yontem Anlamsiz parametreler (Katsayilar)
Benzerlik Yok
Afin (1° polinom) Yok
1° polinom (Afin) Yok
2° polinom 4,5,6,10ve 12
3° polinom 4,5,6,7,8,9,10, 14, 16, 17,18, 19 ve 20
4° polinom 4,5,6,7,8,9,10,11, 12, 13, 14, 15, 19, 20,
21,22,23,24,25,26,27,29 ve 30
4,5,6,7,8,9,10,11, 12, 13, 14, 15, 19, 20,
5° polinom 21, 25,26, 27,29, 32, 33, 34, 35, 36, 37, 38,
39, 40, 41, 42
Afin izdiisiim 4
Genel afin izdlisiim
OrbView-3 i¢in gelistirilen model 4,5, 6vel3
IKONOS&QuickBird i¢in gelistirilen model 4,5,6,11ve 12
Projektif 7 ve 8
DLT 4,5,6ve’7
1° RFM 4,5ve7
2° RFM 9,10,12, 14, 15,16, 17, 18, 19, 23, 25, 26,

1,2,3,4,5,6,7,8,9, 10, 11, 12, 13, 14, 15,
16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27,
28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39,
3° RFM 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51,
52, 53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63,
64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75,
76,77 ve 78

GeoTransfom’da noktalara ait diizeltme vektorel sonuclarini almakta miimkiin oldugu daha
onceki boliimlerde bahsedilmekteydi. Uygulama olarak Zonguldak ili merkezini kapsaya
GOKTURK-2 pankromatik uydu goriintiisii ile vektdrel sonuglarda alinmistir. 62 YKN
noktasina ait normellestrime yapilarak elde edilen vektorel sonucglar Sekil 4.1-15°de

sunulmustur.
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588 Pixel

Sekil 4.1 Benzerlik doniisiimii ile elde edilen hata vektorleri.

5@ Pixel

Sekil 4.2 Afin (1° polinom) doniisiimii ile elde edilen hata vektorleri.
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2@ Pixel

Sekil 4.3 1° polinom (Afin) doniigiimii ile elde edilen hata vektorleri.

58 Pixel

Sekil 4.4 2° polinom Doniisiimii ile elde edilen hata vektorleri.
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50 Pixel

Sekil 4.5 3° polinom doniigiimii ile elde edilen hata vektorleri.

20 Pixel

Sekil 4.6 4° polinom doniigiimii ile elde edilen hata vektorleri.
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38 Pixel

Sekil 4.7 5° polinom doniigiimii ile elde edilen hata vektorleri.

38 Pixel

Sekil 4.8 (Afin izdiisiim) Genel afin izdlislim doniisiimii ile elde edilen hata vektorleri.
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38 Pixel

Sekil 4.9 (Afin izdiisiim) OrbView-3 i¢in gelistirilen model doniisiimii ile elde edilen hata
vektorleri.

30 Pixel

Sekil 4.10 (Afin izdiisiim) IKONOS&QuickBird i¢in gelistirilen model doniigiimii ile elde
edilen hata vektorleri.
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3@ Pixel

Sekil 4.11 Projektif doniisiimii ile elde edilen hata vektorleri

3@ Pixel

Sekil 4.12 DLT doniisiimii ile elde edilen hata vektorleri.
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28 Pixel

Sekil 4.13 1° RFM doniistimii ile elde edilen hata vektorleri.

5 Pixel

Sekil 4.14 2° RFM doniistimii ile elde edilen hata vektorleri.
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1 Pixel

Sekil 4.15 3° RFM doniistimti ile elde edilen hata vektorleri.
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BOLUM 5

SONUCLAR

Konumsal bilisim sektorii giin gectikge gelisen bir sektordiir. Bu sektoriin altyapisini olusturan
bilimsel calismalarda pek cok akademik yazilim kullanilmaktadir. Bu sayede verinin
iiretiminden son {iriiniin elde edilmesine kadarki tiim siire¢lere hakim olunabilmektedir.
Bilimsel arastirmalarda ticari ve kapali kutu yazilimlarin kullanilmasinin ise kullanilan
yontemlerin ve siireglerin etkilerine tam olarak hakim olunamamasi gibi nedenlerden bazi
sakincalart mevcuttur. Buna g¢are olarak, giin gectikce daha ¢ok arastirmact MATLAB gibi
kolay programlama olanagi sunan yazilim altyapilarin1 kullanarak, mevcut ticari yazilimlara
kendi kodlarmi ekleyerek (6rnegin IDL gibi) kendi kod dosyalarini olusturmakta veya C, C++,
C#, Pyhton ya da Java gibi yazilim dilleri ile kendi tiimlesik yazilimlarini olusturmaktadirlar.
Bu yazilimlarin bazilarinin kodlarma eriserek gelistirmek miimkiin iken bazilarin ise sadece
aragtirma/egitim lisansi ile kullanmak miimkiindiir. 2003 yilindan beri gelistirilen GeoEtrim
gilintimiize dek MATLAB ortaminda derlenen bir yazilim iken C# ortaminda yeniden derlenerek
tiimlesik bir yap1 kazandirilmaya calisilmistir. Boylece hem diger arastirmacilarin kolaylikla
kullanabilecegi bir 6zellik kazanmis, hem de alt yazilimlarin farkli kisilerce bir ekip olarak

gelistirilmesinin temeli atilmistir.

GeoEtrim, Zonguldak Biilent Ecevit Universitesi Geomatik Miihendisligi Boliimii GEO468
Uzaktan Algilamada Konumsal Uygulamalar dersi kapsamindaki 6dev uygulamalarinda
kullanilmaya baslanmis ve bdylece ilk kullanict grubu olusturulmustur; boylece kullanici grubu
ile alinan geribildirimlerle gelistirilmektedir. Ayrica GeoEtrim yaziliminin agiklarini bulmak

kullanict yorumlari almak iginde ilk kullanici grubundan faydalanilmistir.

Kullanici sayisini artirmaya ve kullanicilardan goriis almaya siirekli devam edilmektedir. Bu
kapsamda 18-21 Eyliil 2018 de Eskisehir’de diizenlenen UZAL-CBS Sempozyumunda hem
tezin bildirisi sunulmus hem de GeoEtrim yazilimin ilk akademik tanitimi yapilmistir.

Akademik anlamda veya kisisel kullanici goriisleri siirekli alinmaya devam edilmektedir. Bu
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takibi saglamak adina “www.geoetrim.org” web adresi ve “geoetrim@gmail.com” mail adresi

acilmistir. GeoEtrim’in kullanici kullanma kilavuzu Ek Agiklamalar A’da sunulmustur.

5.1 HEDEFLER VE ONERILER

Yazilim alan1 gelistirilmeye siirekli devam edilmesi gereken bir disiplindir. Yeni yontemler ve

teknikler GeoEtrim veya GeoTransfor’a giincellemeler halinde eklenmeli ve yasayan bir sistem

olmalidir. Bu baglamda GeoEtrim’e 6ncelikli hedeflerini ve gelistirilmesi gereken yerler igin

Onerileri su sekilde listeleyebiliriz:

1.

GeoEtrim gelistirilme esnasinda goriintii verisinin tamamini anlik veri saklama birimi olan
“RAM (Random Access Memory)” lizerinde tutacak sekilde programlanmistir. Bu durum
da GeoEtrim’de biiyilk boyutlu goriintiilerin okunmasi, biiyiilk boyutlu goriintiilerin
islenmesi ve biiyiik boyutlu goriintiilerin {izerinde noktalarin toplanmasi iglemlerinim
yapilamamas1 gibi yazilim hatasina yol agmistir. GeoEtrim’in goriintliyli okuma yiikii
RAM’den alinarak, sabit diske verilecek sekilde yeniden optimize edilmelidir. Boylece
GeoEtrim’in biiyiik goriintiilerde yasadigi bu RAM tagma sorunu giderilebilir. Bu sorun en
kisa zamanda asilacaktir. Ancak simdilik bu sorunu GeoTransform alt yaziliminda goriintii
verisi kullanilmadan sadece nokta verisi kullanilarak asinilabilmektedir.

GeoEtrim’in kod yapist ve kullanici arayiiz dili Ingilizcedir. Ingilizce secilmesinin
nedenleri tezde ayrica sunulmaktadir. Ancak GeoEtrim’in kullanict ¢esitliligi agisindan
0zelikle kullanici arayiiz diline farkli dil yamalar1 kazandirilacaktir.

GeoEtrim’e sayisal yiikseklik modeli kullanilarak 3B konum dogrulu islemlerinin
yapilabilmesini saglayacak sekilde gelistirilecektir.

GeoEtrim’in MATLAB siiriimiinde var olan GeoSpot, Geo301 ve GeolP alt yazilimlarina

da arayliiz kazandirilip tiimlesik bir sekilde GeoEtrim’e baglanacaktir.
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EK ACIKLAMALAR

EK A: Kullanma Kilavuzu

e GeoEtrim “www.geoetrim.org” adresinden kullanici anketi doldurmak kaydiyla
edinilmektedir.

e GeoEtrim Windows 10 ve Windows 7 isletim sistemlerinin 64 bit siliriimlerine
kurulmaktadir.

e GeoEtrim’i kurulduktan sonra bir ay boyunca kullanabilirsiniz. Daha uzun siire kullanimi

i¢in lisans anahtar1 girilmelidir.

Register Product e

User

MName: “ |

Surname: | |

Mail: | |

Key: | |

ctivate Last 30 days

e GeoEtrim ¢alismak i¢in bir proje olusturulmadir.

e Proje olusturmak icin ya yeni proje acilmali yada daha once kayit edilmis bir proje
GeoEtrim’e ¢agrilmalidir.

e Yeni proje agmak icin “File => New Project” sekmeleri secilmelidir. Ya da kisa yol
cubugundan dogrudan ‘“New Project” logusuna tiklanmalidir. Tiim bunlarin yaninda

“ctrl+N” tusuna da basilarak yeni proje agma penceresi agilabilir.
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A& Mew Project X

oertion: | |
Name: | | | Create
Information: | |

Yeni proje agma penceresinden projenin ismi ve kayit edilecek dosya adresi belirtilmelidir.
Yeni proje agma penceresinden istege bagli proje hakkinda bilgi girilebilmektedir.

Proje acildiktan sonra ana pencerede agilan projenin isimi dosya diizen paneline gelecektik.
Dosya diizen panelinde proje ilizerinde fare ile sag tiklanarak proje bilgisine erisilebilir.

) MR B < Active: None | A € (4= = 4+ $ o |lul @

Information X

Proje name: deneme.gpr

Proje Information: Bu bir denemedir.

Image Image Image Image GCP count ICP count
file name bands width height

GeoEtrim’de proje igine goriintii aktarilabildigi gibi dogrudan nokta verileri ile ¢aligmakta
miimkiindiir.

Goriintii aktarmak i¢in “Tools -> Image -> open” sekmeleri segilebilecegi gibi dogrudan
kisayol ¢gubugu iizerindeki “Image open” logosuna da tiklanabilir.

GeoEtrim 16 bit veya 8 bit piksel yapisinda, 155 farkli raster (.png, .bmp, .tif, .pix, .jpeg,
.geotif, .jpeg2000 ...) goriintii formatin1 desteklemektedir.

Dosya diizen panelinde, projeye aktarilan gorlintiiler proje isminin altinda sirayla yer
alacaktir.

Dosya diizen panelinde goriintiiye fare ile sag tiklanarak goriintii bilgisine erismek

mumkuindiir.
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= ™ & < | Active:(img)image.tif | H S O [ 4= o
B~ Project: deneme.gor

-8 Image: deneme

(-4 Image: IMG_PHR1A_MS_201304240855126_SEN_6202

(-4 Image: lyrstck_23456_10092016tF

Bs Image: image tif

o Band

-{f| GCPACP
Information X
Driver: GTiff/GeoTIFF ~

Files: C:\Users\yunus\Dropbox\Gokturk_2

\Goruntu\Zonguldak_Merkez\L1\@\image.tif

Size is 8168, 8192

Coordinate System is ~'

Metadata:
TIFFTAG_RESOLUTIONUNIT=2 (pixels/inch)
TIFFTAG_SOFTWARE=Irfanview
TIFFTAG_XRESOLUTION=96
TIFFTAG_YRESOLUTION=96

Image Structure Metadata:
INTERLEAVE=BAND

Corner Coordinates:

Upper Left ( 0.9, 8.8)

Lower Left ( 2.8, 3192.8)

Upper Right ( 8168.8@, 8.8)

Lower Right ( 816@.8, 8192.8)

Center ( 4080.8, 4095.0)

Band 1 Block=816@x1824 Type=Byte,

ColorInterp=Palette
Color Table (RGE with 256 entries)

2: 8,0,0,255
1: 1,1,1,255
2: 2,2,2,255
< 3: 3,3,3,255
I 4: 4,4,4,255 e
e - - - - -

Her hangi bir goriintii izerinde ¢alismak istediginizde dosya diizen panelinde o goriintiiyii
cift tiklamaniz yeterli olacaktir. Bu sekilde birden ¢ok goriintii ile ayni anda ¢alismaniz
mimkiindiir.

Dosya diizen panelinde her goriiniin altinda o goriintiiye ait bantlar ve nokta goriiniim

secenegi gelecektir.

=- \(’ Project: deneme.gpr
=-#¥ Image: deneme

48 Band {null)

GCP/ACP

=4 Image: IMG_PHR1A_MS_201304240855126_SEN_6202

=-{g Bands

: Red band

I Green band

Green histogram

+ I Blue band

-{wf] GCP/ICP

=-#® Image: lyrstck_23456_10092016 £if
=g Bands

. Red band

E|I Green band

tee = Green histogram

Blue band
B
=- Band 5
“ '~ Band 5 Histogram
CP/ICP
- Image: image tif
=g Band
=

GCP/ICP

Dosya diizeni panelinde batlarin altinda o banttin histogram verisi bulunmaktadir.

Dilerseniz ¢ift tiklayarak bu histogram grafigine erismek miimkiindiir.
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al Green histogram — [m] X
Histogram
Intensity
o Intensiy
16
14 ]
@
<
2
E
5
3
o
100 150 200 250 300
Value

e Goriintii verisinde karsithik ayari yapmak icin “Tools=>Image=>Contrast” se¢enegi
tiklanmal1 yada kisayol penceresinden “Contrast” logosu secilmelidir.

e Agcilan pencerede otomatik veya manual “Contrast” ayar1 yapilabilmektedir.

\_M5_201304240855126_SEN_620269181-002_RICL.TIF | & < 0 4= = 4+ § o |ul @& 1 MS_201384248855126 SEN 626269101-802 RICL.TIF | % = 1 (4= = + § 4 [lu @

44 Contrast pd f 44 Contrast K

1 Defualt 3.5 Increase

Contrast Contrast
Histogram Histogram
() pefualt @ Auto () Manual A

@® Defualt O Aute O Hanual e e

e GeoEtrim’de takip paneli caligma alanin1 takip etmektedir.

e Takip panelindeki cergevenin yerini degistirerek c¢alisma alanmmi da kaydirmak

mumkuindiir.
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e Goriintii verisi lizerinde nokta toplamak i¢in “GCP/ICP Collection” penceresi agilmalidir.
e Nokta toplama penceresine “Tools => GCP => GCP/ICP Collection” sekmesinden veya

“GCP Collection” kisayol logosundan erismek miimkiindiir.

44 GCP & ICP Collection - o x
Manual Load
working Image: image.tif SCP/ICP aromse
A& GCP BLICP Collection = O X
Load
point Info Distribution of Points Point Info
it [ s o Foint ID: I:l #GCP= @
Point type #1CP= @
ST — A |
cmom: [ ][] o ow0: [ Jw-[]P
e - [1]- com i [ [ ]?
e L
e L estig cO: | |w-[ ™
pelete Edit [ Auto locate view

w0 [ o [
age Ground Ground Ground
: A T L

e Nokta penceresi acikken, ana pencerede goriintiide herhangi bir yere tikanirsa, tiklanan
yerin koordinatlar1 nokta toplama penceresine otomatik yazilacaktir.

e (Goriinti verisi kullanmadan, nokta verilerini manuel olarak da girmek miimkiindiir.
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ERFTY a x

Manual Load

working Inage: insge.tif ecr/1ce Browse

Lo
Boint TInfa Distribution of Points
roint 10: #GCP= 62
roint tyce Contral | arcPe @
Row (pix) AY5E +/- P
colun (pdx): |312) = P
asting (x): +f =
sorting [¥): +- -
weight (2): o -
Delete Edit [0 Aute locate iew

[TERT] 11,518

[m L meetrel || SIS || SN | JIISMLING ASERILSTS | 1560
a5 Control 5988.599 £53,914 393767354 ASEBESAL. 201 135,654
a7 e
= contral 21,78 1566.710 IO ASSNR.667 11350

Row (pix): 4943 Column (pix): 3339 Zoom Scale: 1

Noktalarin nerede oldugunu takip etmek i¢in “Auto locate” sekmesini isaretleyebilirsiniz.
“Auto locate” segcenegi isaretliyse nokta toplama penceresinden se¢ilen herhangi bir nokta

ana penceredeki goriintiide ki yerine gelecektir.

Nokta toplama penceresinde “Edit” tusuna tikalnirsa nokta diizenlenebilmektedir.

82



A& GCP &LICP Collection — - »

Manual Load

Working Image: image.tif GCP/ICP Browse
Load

Point Info Distribution of Points

Point ID: 35 #GCP= 62

Row (pix): |5988.89 |+f— p
column (pix): [653.914 | +- p

Easting (X): |393?6?.354 |+f— m
Merting (v): |4588942.292 |+f— m
m

ueight (2): |135.594 |+f—
oK [ aute locate view

Image G Ground
Row

Point -
ID

26 6585.973 144,935 392846.625 4587479.223 152.864
27 control 62793.579 131.518 J926EE8.608 45EEE26.183 177.911
28 Control &364.638 B45. 894 393944,276 4LEEE1E.979 198.288
37 Control 5747.71e 783.457 393958, 248 45E9586. 898 78.875
48 Control 7621.734 1566.718@ 396E83.888 4585382.667 113.538
42 control 7185.428 1329.555 395994, 869 45BE26E. 858 258.983

Noktalar1 geoEtrim’de disar1 aktarmak icin “Export GCP/ICP into text file” penceresi

ac¢ilmalidir.

Nokta disar1 aktarma penceresini agmak i¢in “Tools => GCP => Export” sekmelerine

tiklanmalidir.
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A& Export GCP/ICP into text file — O >
Working Image
image: tif ~
Point ID Opticns
Point Type Number of decimal place for coordinates: 3 |
Row
Column Number of decimal place for std walues: |3 [=
, =
Easting (X)
Northing (Y) .
. Separator for decimal place: | dot v|
Height (Z)
Std Row
Std Column Include Separate columns by: |Tah v|
Std X
std v Add Columns Title
Std Z
Location: | | Browse
1 Name : | | Export
Export penceresinde nokta verilerini istediginiz gibi diizenleyebilirsiniz.
1 1 13 2 b b,
Nokta verileri digar1 “.gcp” uzantili text formatinda gitmektedir.
1 Import sequence: 3/1/0/1/2/3/4/5/6/7/8/9/10/11/
2 Image file: IMG_SPOTé_P_201805150822572_SEN_SPOT6_20180528_135213120spTnljadmy 1l.tif
4 PointID PointTybe Row Column X ¥ Z S5tdRow StdCol Stdx StdY S5tdZ
5 26 Control 6505.973 144.935 |392846.625 4587479.223 152.864 0.000 0.000 0.000 0.000 0.000
€ 27 Control €279.579 131.518 352€88.680 4588026.183 177.911 0.000 0.000 0.000 0.000 0.000
7 28 Control 6364.630 ©45.894 393944.27¢ 4588018.979 195.500 0.000 0.000 0.000 Q.000 0.000
8 35 Control 53888.890 653.914 393767.354 4588942.202 135.694 0.000 0.000 0.000 0.000 0.000
8 37 Control 5747.716 783.457 353550.240 4585586.858 70.875 0.000 0.000 0.000 0.000 0.000
10 40 Control T621.734 1566.710 396803.080 4585302.667 113.530 0.000 0.000 0.000 Q.000 0.000
11 42 Control 7185.428 1329.555 395994.06% 4586268.858 250.903 0.000 0.000 0.000 0.000 0.000
43 Control €153.986 1180.022 395095.03% 4588740.963 234.910 0.000 0.000 0.000 0.000 0.000
46 Control 6382.696 1602.263 396214.733 4588350.047 206.941 0.000 0.000 0.000 0.000 0.000
: 51 Control 61259.467 1152.540 355013.302 45887%2.%41 225.370 0.000 0.000 0.000 0.000 0.000
15 52 Control €149,559 962.516 394574.86€3 4588672.470 216.455 0.000 0.000 0.000 0.000 0.000
16 54 Control 5823.385 830.452 394099.698 4589419.577 91.5%2 0.000 0.000 0.000 0.000 0.000
17 55 Control 5806.5%6 882.658 354213.924 458%482.22% 385.59& 0.000 0.000 0.000 0.000 0.000
18 59 Control 5637.720 1206.107 394900.462 4590024.026 -1.139 0.000 0.000 0.000 0.000 0.000
&2 Control 5510.322 1489.331 395455.721 4590439.582 -3.466 0.000 0.000 0.000 0.000 0.000
1 Control £13%9.547 1630.358 39€162.757 4588%958.046& 109.321 0.000 0.000 0.000 0.000 0.000
(35 Control 5886.113 1930.957 396750.933 4589700.338 §.922 0.000 0.000 0.000 Q.000 0.000
71 Control 6456.187 1738.625 396569.700 4588219.914 282.990 0.000 0.000 0.000 0.000 0.000
72 Control 7310.750 2078.312 357832.784 45B86255.141 254.111 0.000 0.000 0.000 0.000 0.000
T4 Control 5647.375 2099.937 397004.382 4590346.339 191.251 0.000 0.000 0.000 Q.000 0.000
79 Control 5020.4086 2186.625 396891.757 4591918.101 35.28& 0.000 0.000 0.000 0.000 0.000
£0 Control 5119.375 2340.563 357310.672 4581735.121 51.537 0.000 0.000 0.000 0.000 0.000
85 Control 5657.000 2770.125 398615.407 4590586.679 115.133 0.000 0.000 0.000 Q.000 0.000
90 Control 5288.063 2959.625 398877.947 4591565.140 0.286 0.000 0.000 0.000 0.000 0.000
83 Control 5347.500 3144.531 355354.454 4551452.806 5.283 0.000 0.000 0.000 0.000 0.000
a5 Control 4711.000 3079.250 398856.642 4593022.027 19.829 0.000 0.000 0.000 Q.000 0.000
98 Control 5774.000 3118.000 399519.312 4590440.580 10.49& 0.000 0.000 0.000 0.000 0.000
100 Control €528.750 3419.375 400819.879 4587719.820 339.165% 0.000 0.000 0.000 0.000 0.000

GeoEtrim’de noktalar igeri aktarmak i¢in “Import” penceresini agmak gerkir.

“Import” penceresine nokta toplama penceresinin “load” panelinden erigilmektedir.
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A& Import - X
Import and Close working Image: C:‘\Users\yunus\Dropbox\Gokturk_2\Goruntu'\Zonguldak_werkez'L1\@\image.tif
Row Count= 62
Porrt ID %‘j": mage frege Ground Ground Ground StdRow  SdCol Std X Std Y sdz
Control 6505.973 144935 392846625 |4587479.223 |152.864 0.000 0.000 0.000 0.000 0.000
27 Control 6279.579 131518 352638.680 |4588026.183 (177911 0.000 0.000 0.000 0.000 0.000
28 Control 6364.630 645854 393344 276 | 4588018.973 |198.800 0.000 0.000 0.000 0.000 0.000
35 Control 5988.830 653914 393767.354 |4588942.202 (135694 0.000 0.000 0.000 0.000 0.000
37 Control 5747.716 783.457 393950240 |4589586.898 |70.875 0.000 0.000 0.000 0.000 0.000
40 Control 7621.734 1566.710 396803.080 |4585302.667 |113.530 0.000 0.000 0.000 0.000 0.000
42 Control 7185.428 1323.555 395394.06% |4586268.858 |250.903 0.000 0.000 0.000 0.000 0.000
43 Control £153.986 1180.022 395095.039 | 4588740963 (234910 0.000 0.000 0.000 0.000 0.000
46 Control 6382.696 1602.263 396214733 | 4583350.047 |206.941 0.000 0.000 0.000 0.000 0.000
51 Control 6123.467 1152.540 395013.302 | 4588732541 |228.370 0.000 0.000 0.000 0.000 0.000
52 Control 6£149.559 962 516 394574863 | 4588672470 |216.455 0.000 0.000 0.000 0.000 0.000 v
£ >

Noktalar1 iceri atma penceresinde noktalar1 6n izleme yapilmaktadir. Noktalar onay
verildikten sonra projeye dahil olacaktir.

GeoEtrim’de “.gcp” veya “.txt” formatinda nokta dosyasi okunabilmektedir.

“txt” formatinin okunmasi i¢in metin dosyasinda hi¢ bos satir olmamali ve nokta verileri
sirastyla; noktanin numarasi, tipi, satir koordinati, siitin koordinati, Kartezyen
koordinatlar1 ile tiim koordinatlarin standart sapmalar1 seklinde hazirlanmis olmalidir.
Ayrica nokta verileri kendi aralarinda “tab” tusu ile ayrilmalidir.

GeoEtrim kendi formati olan “.gcp” nokta dosyasini ne sekilde hazirlanmis olursa olsun
okuyabilmektedir.

Sadece nokta verisi bulunmasit durumunda goriintii verisi kullanmadan nokta verisi ile
calismak i¢in bos tuval agmalisiniz.

Bos tuval agmak icin “Tools => Image => Empty 1mage” secenegini ya da kisayol

cubugunda “Empty image” logosunu tiklamalisiniz.

A4 Working without image w0

Mame : | |

GCP/ICP file: | | Browse

sackground color: | I SN - |

GeoEtrim’de projeden goriintii silmek i¢in dosya diizen panelinde goriintiiyli segcmeli ve
kisayol cubugunda “Delete 1image” logosuna tiklamalasiniz.

GeoEtrim’de projenizi “.gpr” uzantili, XML formatinda saklayabilirsiniz.
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Dosyaniz1 saklamak i¢in “File => Save Project” sekmelerine veya kisayol ¢ubugundan

“Save Project” logosuna tiklamalisiniz. Tlim bunlarin yaninda projenizi klavyede “CTRL

+ S” tusuna basarak da saklayabilirsiniz.

<g°p
<g°p
<g°p
“gep
<g°p
<g°p
<g°p

<gcp BointID="T74"

"' 392668 . 68"
93944.2
93767.3

4586026.1683
BE016.979
58942 .202

393950. 24" 45389586 .696

396E03 . DE" 4585302 . 667
"395994 . 069" Y="4586266.B858"
"395095.039" Y="4588740.963"
"396214.733" Y="4588350.047"
395013.302" Y="4566792.94
1394574 BE3" Y="45BBET2. 47
"394099 . 696" Y="4569419.57
394213 . 924" Y="4569482.22
K="394900.462" Y="4590024.02
" K="395455.721" Y="4590439. 552"
"39E1E2. 15T Y="455B058 . 046"
396750 933" "4589700. 338"

" 396569 7" B56219.914

" 397832.784" Y="45B6255.14
" Colunn="2099.937" X="397004.362" Y="4590346.339"

GeoEtrim’de sakladiginiz “.gpr” uzantili projenizi tekrar cagirmak icin “File => Open

project” sekmelerini se¢gmeli ya da kisayol ¢ubugundan “Open Project” legosunu

tiklamalisiniz. Tiim bunlarin yan1 sira projeniz tekrar agmak icin klavyeden “CTRL + O”

tusuna basabilirsiniz.

GeoEtrim’de panellerin veya noktalarin renklerini yada yazi tiplerini “Visual Settings”

penceresinden degistirilmektedir.

Gorsel ayarlama penceresine girmek i¢in “Tools => GCP => Visual Settings” sekmelerine

tiklanmalidir.

A4 Visual Settings

GCP/ICP
GCP
Font type: |Consolas v|
Font size: 1@ =

Point size: 23.@ =

Line width: 2.8 =

.Red ~

Point color:

Show GCP by

Type:
10:
| GCP-427
Cancel

Points GeoTransform

Icp

Font type: |Consolas v|

Font size: 18

Font color: | Agqua v|

Point size: 23.@ =

Line width: 2.8 =

Point color: | Aqua ~

Show ICP by
Type:

ID:

Default Apply
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GeoEtrim’de hesap iglemleri yapmak i¢in “GeoTranform” alt yazilimina girilmelidir.

GeoTranform alt yazilimma girmek i¢in “Modules => GeoTransform” sekmeleri

secilmelidir.

4 GeoTransform

Working Image Report
metrics (pixel)
image.tif v mre 2 [vrl=
nc= t0 [vel= @
Properties mo= 9 [wl= e
Mat model: similarity (Helmert) -
Foints (processed/total)= 62/62
Hodel I Generic affine projection -
Degree of freedom= 120
slunder test: |wormal distribution -
Apriori 0= [L.e
Use weight
apply Normalization:

&

6279.579

Control 5823.385

59.000 Control 5637.720

66.000 Control 6139.547
71.000 Control 6456.187

74.900 Control 5647.375

Control 5119.375

80.600
g eseee | comtew | seweee |

' 5 pixel

131.518

653.914

1566.716

1180.822

1152.546

838.452

1206.187

1638.358

1738.625

2899.937

2348.563

Show image:
vector scale=
Vector thicknees=
PoLNt size=

Graphical scales

Vector scale= 12.6 |3

vector thicknees=

392688.6550 177.911

4588026.183

393767.354 4588942282 135.694

396383850 4585382 . 667 113.538

395095.839 234.910

4588748.963

395013.382 4588792.941 228.370

394299598 4589419.577 91.582
394980462 4598824826 -1.139
396162.757 4588955846 109.321
396569.768 4588219.914 282.990
397084 .382 4598346.339 191.281
397310.672 4591735.121 51.537

Froperties

Mat model: Similarity (Helmert)

Similarity (Helmert)

Affine (1st degree polynomial)
Polinomial

Affine projecticn

Blunder test: [Projective

DLT

RFM (GCP_dEpendent}

m
=
[}

L=

Apriori O.= —

GeoTransform’da Properties panelinden doniisiim modeli se¢ilmektedir.

Properties
Mat model: Affine projection ~
Model ID: Generic affine projection

Generic affine projection
AP for Orbview - 3
Blunder test: |AP for IKONOS & Quickeird

GeoTransform’da Properties panelinden uysumsuz 6l¢ii testi tipi secilmektedir.

Blunder test: |mormal distribution

Apriori o.= T distributicn
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e GeoTransform’da Properties panelinden normalizasyon, dongii iist sinir1 ve esik degeri

ayarlar1 yapilmaktadir.

Apply Normalization:
g.1e8 |
c -

e (GeoTransform’da doniisiim islemi icin gerekli ayarlar1 yaptiktan sonra “Apply” tusuna

basilmalidir.

e GeoTransform’da genel sonuglar “metrics (pixel) panelinde sunulmaktadir.

Metrics (pixel)

mr= #1.81 [vr]= e.e8
mc= #4.78 [vc]= e.e8
mo= #3.61 [vw]= e.e8

Points (processed/total)= &2/62
Degree of freedom= 115

Same parameters are inwvalid.

e Doniisiim modelinde katsayilarinda anlamsizlik var ise GeoTransform panelinde “Same

parameters are invalid” seklinde mavi link verilecektir. Bu link’e tiklandiginda anlamsiz

parametreler goriilecektir.

Metrics (pixel)

mn |nformation >

mg

ma o Parameter id: 4

Pd 2
D

Same parameters are invalid.
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e Noktalarinin iki farkli vektorel sonuglar1 GeoTransform’da sunulmaktadir.

e Vektorel gosterimlerle ilgili gorsel ayarlamalar1 GeoTransform penceresinde

yapilmaktadir.
Show image:
vector scale= 158.5 (=
vector thicknees= 2.8 |=
Point size= 6.5 |=
Graphical scale= 5 =
Clear View
vector scale= G88.8 =
vector thicknees= 2 =

e GeoTransform nokta tablosunda uyusumsuz noktalar ve diizelme sonuglar1 goriilmektedir.
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4588826, 183 177.911

ASERS4T. 20 135.694

113.538

234,910

387310.672 4551735121

e (GeoTransform’da panellerin veya noktalar1 rengini veya yazi tiplerini degistirmek igin

GeoTransorm penceresinde bulunan “View” tusuna basilmalidir.

A izual Settings >
GCP/ICP Points GeoTransform
Vectors of points Wind rose

Background: | Controllight v| Background: ‘ ContrelLight

Canvas: | White V| Canvas: ‘ White

Color: |.RE€| V| Color: ‘.Blue'u’iolet

Settings for GCP/ICP list

Back color: |.hpp'-i0r‘k5pace V| Title font size:

v
¥
Y|
Title font type: |Consolas V| Walues font size:

Values font type: |Consolas V| Number of decimal place:

Cancel Default Apply

e GeoFEtrim yazilimi ve GeoTransform alt yazilimi ile ilgili gelismeleri ve gilincellemelerini

takip etmek i¢in “www.geoetrim.org” adresini ziyaret edebilirsiniz.
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Yorum ve destek icin “geoetrim@gmail.com” adresine elektronik posta génderebilirsiniz.

Geo€lrim

geospatialy yours

Copyright © zoz8 - All rights reserved.

. geoetrin, org
Team

dsev -
(Originator and Manager) (Develeper)
Bilent Ecevit University Bilent Ecevit University
Dept. af Dept. o
Geomatics Engineer Geonatics Engineer
topangbeun. edu. tr yunusenreelikfgnail. com

With the ceatribution of

Muh, AlL CamM
¥rd, Dog. Dr. Mirsel Ozan fmCETAS
uzm. Muret Orug
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